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INTRODUCTION

Understanding and customizing the Login Manager (Manager-controlled options, Preferences and Settings) for the logins on your server 
is the key to optimizing the use of all Millennium modules for your library's particular needs, policies and practices. This tutorial is 
designed to be used as a guide for setting up new logins, and as a reference for later questions. It covers Manager-controlled options, 
Preferences and Settings as they are used in all Millennium applications.  
 
The tutorial as a whole can be used in different ways.  
 
Step-by step 
For the new system administrator, or for the customer who is just beginning to implement their Millennium system, it can be followed 
in a step-by-step manner, using the « previous and next » navigation icons, in which case it will cover all options in all modules, 
following the structure of the Manager-controlled options, Preferences and Settings tabs.  
 
Module based approach 
A second way to use the tutorial, particularly suited to the department supervisor who is primarily interested in a single module, is to 
use the module based approach. Using the Millennium Modules menu, select the module (Circulation, for example) in which you are 
interested. An image of the tabs used by that module, including the options appropriate for that module, can be used for links. In that 
case you would use the browser's Back button to return you to the Millennium Modules menu page, and then you would choose the 
next tab.  
 
Reference guide 
Finally, customers who wish to use the tutorial as a reference guide to information about the uses or consequences of a particular 
setting can use the Manager-controlled options, Preferences and Settings menus to go directly to the page with the information about 
the setting in question. 
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NAVIGATION & REQUIREMENTS

●     Links near the top of each page lists each section in the tutorial, with your current location. You can select a different section 
from the link. 

●     At any time you can select from the drop down menus on the navigation bar across the top of each page. 
●     Links to pages outside the tutorial open in a separate browser window. To return to the tutorial, close the external link window, 

or click on the tutorial window to make it active. 
●     Hot Tips are used to highlight information that either illustrates or expands a point in the tutorial text. 
●     Moving graphic examples are included on some pages. To view them you need the Flash plugin on your computer. 

●     You can download the latest Flash Player from Adobe web site  

 
 
Recommended Web Browsers for optimal viewing 

●     Internet Explorer 6.0 and above 
●     Mozilla Firefox 1.5 and above 
●     Mac: Safari 1.2 and above 

Printing  
 
You can print individual tutorial pages and screens from within a Web browser using the 'Printer friendly page' icon  
 

  
 
The complete tutorial can also be printed in PDF format. To view and print it you need Adobe Acrobat Reader software which you can 

download from   
 
Please contact us if you have questions, comments or problems. 
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CREATING A LOGIN

Each login associated with a Millennium module can have different sets of options defined. Before you start customizing your 
Millennium modules you need to set up your logins.  
 
Millennium logins are created from within the Login Manager. To access the Login Manager, you must be authorized for function 187 
(Login Manager). To work with logins, you need to be authorized for the following: 
721 (Create Login) 
722 (Edit Login) 
723 (Delete Login)  
 
To open the Login Manager, choose Admin | Login Manager from the top menu within any Millennium module.  
 

 
 
 
All Millennium logins that are currently setup will display, along with buttons for creating, editing and deleting logins:  
 

 
 
 
All Millennium modules and the Millennium control bar have default logins on new systems, as follows:  
 
milacq - Millennium Acquisitions 
miladmin - Millennium Administration 
milcat - Millennium Cataloging 
milcirc - Millennium Circulation 
milerm - Millennium Electronic Resource Management 
milill - Millennium Inter-Library Loan 
milser - Millennium Serials 
miltool - Millennium Control bar  
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The setup on your system will differ based on the modules your organization has acquired.  
 

The default logins are usually used during training. The password is always the same as the login name. After 
training you can adjust or delete them. You should at minimum change passwords, since all systems have the same 
default setup.

 
 
To edit an existing login, highlight the login name in the list and press Edit Login button, or use keyboard alternative Alt-E. 
To create a new login, press button Create Login, or use keyboard alternative Alt-C. For detailed instructions on how to maintain 
Millennium logins, refer to the Innovative Guide and Reference, Page # 106352: Millennium Login Administration.  
 
Logins can be created as needed, depending on your organizational structure, access to printers, need for different options, etc.  
 
NOTE: Logins for the WebPAC and character-based system applications must be set with the System Administration character-based 
function. For instructions, refer to the Innovative Guide and Reference, starting at Page #101722: Login Administration  
 
Important note about use of Millennium control bar  
 
The Millennium control bar is a small window of icons on your desktop. The icons represent all of the Millennium applications your 
organization uses, as well as other applications such as WebPAC and the Innovative Guide and Reference. Clicking an icon on the 
Millennium control bar starts an application in a new window. The control bar itself does not use a user license, but each Millennium 
module opened uses a license (just as they do if you were to open multiple modules from a desktop icon). 
Icon descriptions can be viewed by placing the cursor over an icon:  
 

 
 
 
The Millennium control bar can be accessed in two ways: 
1. From within any Millennium module, click on the Millennium icon at the top of the navigation bar, or use menu Go | Millennium 
Control Bar:  
 

 
 
 
2. Use a login associated with Millennium control bar. The login will launch the control bar, from which any module can be accessed.  
 
In both cases, the customized settings for the login that was originally used to open Millennium will apply to all modules that are 
subsequently launched from the control bar. 

file:///C|/PROJECTS/TUTORIAL%20LoginManager%202008%20-%20UPDATES/print_intro3.html (2 of 3) [10/27/2008 11:05:20 AM]

http://csdirect.iii.com/manual/gmil_login_admin.html
http://csdirect.iii.com/manual/i_addlsysfunc_login_administr.html


CREATING A LOGIN | Login Manager

close window

file:///C|/PROJECTS/TUTORIAL%20LoginManager%202008%20-%20UPDATES/print_intro3.html (3 of 3) [10/27/2008 11:05:20 AM]

javascript:window.close()


OVERVIEW OF CUSTOMIZING OPTIONS | Login Manager

OVERVIEW OF CUSTOMIZING OPTIONS

There are three ways of customizing a Millennium login:  
 
Manager-controlled options 
Manager-controlled options define the behavior of a Millennium module for a particular login. 
Manager-controlled options are controlled from the Login Manager. 
To access the Login Manager, you must be authorized for function 187 (Login Manager). 
To open the Login Manager, choose Admin | Login Manager from the top menu within any Millennium module. 
Manager-controlled options vary slightly between each module.  
 
You can customize the Manager-controlled options for any login regardless of what module you are logged into, but you will only see 
the tabs and options that are associated with the module you are currently using. For example, if you are logged in to Millennium 
Cataloging, and want to customize a circulation login, you will not see the Due Slips, Sounds and other tabs that are specific to 
circulation logins. It is therefore recommended that you be logged into the module for which you plan to customize logins.  
 

Manager-controlled options can be copied from one login to another. 

 
 

When a module is accessed from Millennium control bar, the original login's Manager-controlled options are used. 
Launch all modules likely to be used by that login and modify the module specific values as desired. 

 
 
Some Manager-controlled options override corresponding system options, while others interact with them. For example, you will not 
see the Due Slips tab in Millennium Circulation if Circulation option Check-out: Print date due slips is set to NEVER. 
Relations between Manager-controlled options and specific system options are discussed in the corresponding tutorial sections.  
 
Preferences 
Preferences control the appearance of the module. e.g. colors and fonts, for a particular login. 
Preferences are also controlled from the Login Manager, and accessed in the same way as Manager-controlled options. In addition, you 
can enable access from the Edit menu, using a setting on the Setup tab in Manager-controlled options.  
 
Preferences work the same in all modules, and can be modified from the Login Manager for any login irrespective of what module you 
are logged in to. (Note that the elements in the Colors section vary slightly between the modules)  
 
When a module is accessed from Millennium control bar, the original login's Preferences are used.  
 
NOTE: It is very important that you define a customized set of Preferences for all logins before you make permanent changes to 
Settings (see below). That is, there must be a check in the box for Preferences associated with that login.  
 

 
 
 

Preferences can be copied from one login to another. 
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Settings 
Settings control additional options and behavior within each module, e.g. the use of templates. Settings are accessed via the menu 
Admin | Settings. 
As opposed to Manager-controlled options and Preferences, Settings can easily be changed by any user for a current session. To save 
changed Settings permanently, you must be authorized for function 176 (Save Settings (Millennium)). You can only save Settings for 
the login you are currently using.  
 
NOTE: Before you save permanently, make sure you have defined Preferences, or the saved Settings will apply to ALL logins that don't 
have customized Preferences.  
 
Settings vary slightly between each module.  
 
When a module is accessed from Millennium control bar, the original login's Settings are used. However, some settings can have 
unique default values in each Millennium application, even though the applications are launched from a single login through the 
Millennium control bar. 
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WORKING WITH LOGIN MANAGER

●     Copying Manager-controlled options or Preferences 
●     Deleting customized Manager-controlled options or Preferences 

Access the Login Manager from the top menu, Admin | Login Manager. 
You will see a window looking like this, with all the logins associated with a Millennium application listed:  
 

 
 
 
The System entry at the top is not an actual login. It merely serves as a placeholder for the default option settings for all logins. 
New logins have blank check boxes, which means they are not yet customized. You can use your Millennium system without ever 
changing anything in either Manager-controlled options or Preferences, but you will most likely want to customize at least some 
options. See also the discussion in the previous section about the relationship between customizing Preferences and Settings. 
"Uncustomized" logins use the System defaults.  
 
The list is divided into three columns: Login, Manager-Controlled Options and Preferences. When a line is highlighted you can see a 
thin, white space between each column.  
 
Depending on what you want to do, it is important that you place the cursor in the correct column: 

●     If you are customizing Manager-controlled options or Preferences for a login for the first time, click in the checkbox in the 
appropriate column.  
 

●     If you are editing a login that is customized already: select the login by clicking on the line in the Login column. Then click on 
the Manager-Controlled Options button, or use keyboard alternative Alt-M, alternatively click on the Preferences button or 
use keyboard Alt-P. 

If you happen to click in another column than Login, you will be asked if you want to delete customized settings. 
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COPYING MANAGER-CONTROLLED OPTIONS OR PREFERENCES

When you customize Manager-controlled options or Preferences for a login for the first time you will be asked to copy an existing login.
Using Manager-controlled options as an example: select the line for the login you want to customize. Click in the checkbox for Manager-
controlled options. You will see a dialog similar to this: 
 

 
 
The very first time, before you have customized any of the logins, you will only have the System "login" as an option. After that, all 
logins with customized settings will be available in the list. Highlight the login you wish to copy and press Select, or use keyboard Alt-
L.  
 

To streamline your work: edit the System settings first. You will then avoid doing the same changes each time you 
customize a new login. Remember that if you are working with Manager-controlled options, you should be logged in 
to the module for which you want to customize logins, or you will not see all tabs and options. 

 
 

Tips for large sites: create standard logins, or edit the default Millennium login for each module, so that you can use 
them for the purpose of copying. That will make it much easier to customize a number of logins that will use the 
same settings. 
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DELETING CUSTOMIZED MANAGER-CONTROLLED OPTIONS OR PREFERENCES

If you have customized Manager-controlled options or Preferences for a login, but later want to reset either of them, you can do so by 
clicking in the checkbox in the appropriate column.  
 
The system prompts you to confirm the deletion of the current settings:  
 

 
 
 
Press Yes, or use keyboard Alt-Y to remove those settings for the login. The login returns to using the Manager-controlled options or 
Preferences associated with System, until you customize it again.  
 
NOTE: the system does not allow you to delete the Manager-controlled options or Preferences for the System "login":  
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INTRODUCTION TO MILLENNIUM MODULES

For the system administrator or department supervisor who is primarily interested in setting up logins for a single module, it may be 
easier to use the tutorial in a module-specific way. This section is a guide to the Login Manager by module. For each module you will 
find links to appropriate pages in two of the main sections of this tutorial: Manager-controlled options and Settings.  
 
Preferences are the same for all modules, and are therefore not listed in this section. The only exception is the Colors section on the 
Colors and Fonts tab.  
 
Each of the modules is listed with both a graphic image and a list of the applicable tabs. Note that some options will only appear if the 
library has acquired or installed certain products. These are noted in the explanation of the setting or the tab. 
Use the links to view descriptions of tabs and corresponding options applicable for each module. To get back to the module menu, use 
your browser's Back button, or the drop down menu on the navigation bar. The links will take you to the main page for a particular tab. 
In Manager-controlled options options may vary between modules on each tab. At the top of each page describing the various options, 
you will find icons indicating the modules in which each option appear.  
 
Millennium also uses system options set on the character-based system. On the following pages you will find references to the 
Innovative Guide and Reference and other documentation applicable for a particular module regarding system options.  
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ACQUISITIONS - MANAGER CONTROLLED OPTIONS

●     Data Exchange 
●     Edit
●     Holds
●     Images
●     Login
●     Modes
●     Patron Display
●     Printing
●     Setup

Use the link on the left or click on a tab in the image below to go to the page for the topic of your choice. In order 
to continue with the tabs associated with Acquisitions you will need to use your browser's BACK button to return 
to this menu page.  
 

ACQUISITIONS - SETTINGS

●     Create Lists 
●     Funds 
●     Import Invoice 
●     Invoice 
●     Macros 
●     Multiselection Groups 
●     New Records 
●     Print Templates 
●     Rapid Update 
●     Receive 
●     Recommendations 
●     Record Display 
●     Record Templates 
●     Search 
●     Statistics 
●     Windows 

Use the link on the left or click on a tab in the image below to go to the page for the topic of your choice. In order 
to continue with the tabs associated with Acquisitions you will need to use your browser's BACK button to return 
to this menu page.  
 

Millennium Acquisitions uses many Acquisitions options set on the character-based system. Refer to the Innovative Guide 
and Reference, Page # 100712: Acquisitions Options Used by Millennium Acquisitions.
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ADMINISTRATION MANAGER CONTROLLED OPTIONS

●     Data Exchange
●     Edit
●     Holds
●     Images
●     Login
●     Modes
●     Printing
●     Setup
●     Web Master

 
 
Use the link on the left or click on a tab in the image below to go to the page for the topic of your choice. In order to 
continue with the tabs associated with Administration you will need to use your browser's BACK button to return to this 
menu page.  
 

 

ADMINISTRATION SETTINGS

●     Create Lists 
●     Invoice 
●     Macros 
●     Print Templates 
●     Record Templates 
●     Statistics 
●     Web Options 

Use the link on the left or click on a tab in the image below to go to the page for the topic of your choice. In order to 
continue with the tabs associated with Administration you will need to use your browser's BACK button to return to this 
menu page.  
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CATALOGING - MANAGER CONTROLLED OPTIONS

●     Data Exchange 
●     Edit 
●     Holds 
●     Images 
●     Login 
●     Modes 
●     Printing 
●     Setup 

Use the link on the left or click on a tab in the image below to go to the page for the topic of your choice. In order to 
continue with the tabs associated with Cataloging you will need to use your browser's BACK button to return to this menu 
page.  
 

 

CATALOGING - SETTINGS

●     Create Lists 
●     Export Records 
●     Global Update 
●     Macros 
●     New Records 
●     Print Templates 
●     Record Display 
●     Record Templates 
●     Reports 
●     Search 
●     Session Statistics 
●     Statistics 
●     Windows 

Use the link on the left or click on a tab in the image below to go to the page for the topic of your choice. In order to 
continue with the tabs associated with Cataloging you will need to use your browser's BACK button to return to this menu 
page.  
 

Millennium uses most of the Database Maintencance options set on the character-based system. The few system options not used 
by Millennium are: 
New Item Record (Multiple): Increment copy number 
New Item Record (Multiple): Restart copy number with each location 
Define batch label queues 
Number of seconds for which password is valid 
Use PASSWORDS and AUTHORIZATIONS functions 101-199 
These options do not have corresponding options in the Login Manager, they are governed by other settings, some hardcoded, 
some customizable at the time of use. 
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CIRCULATION - MANAGER CONTROLLED OPTIONS

●     Data Exchange 
●     Edit 
●     Holds 
●     Images 
●     Login 
●     Modes 
●     Patron Display 
●     Printing 
●     Setup 
●     Sounds 
●     Tabs 

Use the link on the left or click on a tab in the image below to go to the page for the topic of your choice. In order to 
continue with the tabs associated with Circulation you will need to use your browser's BACK button to return to this 
menu page.  
 

 

CIRCULATION - SETTINGS

●     Create Lists 
●     Macros 
●     New Records 
●     On-the-fly Records 
●     Print Templates 
●     Record Display 
●     Record Templates 
●     Search 
●     Statistics 
●     Windows 

Use the link on the left or click on a tab in the image below to go to the page for the topic of your choice. In order to 
continue with the tabs associated with Circulation you will need to use your browser's BACK button to return to this 
menu page.  
 

Circulation options set on the character-based system are used by Millennium to a varying extent. Some control Millennium behavior, 
while some Manager-controlled options override corresponding Circulation options, and others interact with them. Relations between 
specific Manager-controlled options and Circulation options are discussed in the corresponding tutorial sections. For a 
comprehensive overview of all Circulation options and their use, refer to Customer Information Resource Circulation Options That Can 
Be Options Grouped on CSDirect. 
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ERM - MANAGER CONTROLLED OPTIONS

●     Edit 
●     Holds 
●     Images 
●     Login 
●     Modes 
●     Printing 
●     Setup 

Use the link on the left or click on a tab in the image below to go to the page for the topic of your choice. In order to 
continue with the tabs associated with ERM you will need to use your browser's BACK button to return to this menu page.  
 

 

ERM - SETTINGS

●     Create Lists 
●     Global Update 
●     Macros 
●     New Records 
●     Print Templates 
●     Record Display 
●     Record Templates 
●     Search 
●     Statistics 
●     Windows 

Use the link on the left or click on a tab in the image below to go to the page for the topic of your choice. In order to 
continue with the tabs associated with ERM you will need to use your browser's BACK button to return to this menu page.  
 

 

Millennium Electronic Resource Management does not have any options set on the character-based system. 
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ILL MANAGER CONTROLLED OPTIONS

●     Data Exchange 
●     Departments 
●     Due Slips 
●     Edit 
●     Holds 
●     Images 
●     Login 
●     Modes 
●     Patron Display 
●     Printing 
●     Setup 
●     Sounds 

Use the link on the left or click on a tab in the image below to go to the page for the topic of your choice. In order to 
continue with the tabs associated with ILL you will need to use your browser's BACK button to return to this menu page.  
 

 

ILL SETTINGS

●     Create Lists 
●     Macros 
●     New Records 
●     On-the-fly Records 
●     Print Templates 
●     Record Display 
●     Record Templates 
●     Search 
●     Statistics 
●     Windows 

Use the link on the left or click on a tab in the image below to go to the page for the topic of your choice. In order to 
continue with the tabs associated with ILL you will need to use your browser's BACK button to return to this menu page.  
 

Some options in Millennium Inter-Library Loans are governed by Circulation options set on the character-based system. 
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SERIALS MANAGER CONTROLLED OPTIONS

●     Edit 
●     Holds 
●     Images 
●     Login 
●     Modes 
●     Printing 
●     Setup 
●     Tabs 

 
 
Use the link on the left or click on a tab in the image below to go to the page for the topic of your choice. In order to 
continue with the tabs associated with Serials you will need to use your browser's BACK button to return to this menu 
page.  
 

 

SERIALS SETTINGS

●     Claiming 
●     Create Lists 
●     Macros 
●     New Records 
●     Print Templates 
●     Rapid Update 
●     Record Display 
●     Record Templates 
●     Search 
●     Statistics 
●     Windows 

 
 
Use the link on the left or click on a tab in the image below to go to the page for the topic of your choice. In order to 
continue with the tabs associated with Serials you will need to use your browser's BACK button to return to this menu 
page.  
 

Millennium uses all the Serials options set on the character-based system. They are all related to label printing. 
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INTRODUCTION TO MANAGER CONTROLLED OPTIONS

Manager-controlled options define the behavior of a Millennium module for a particular login.  
 
Manager-controlled options are set from the Login Manager. To access the Login Manager, you must be authorized for function 187 
(Login Manager). 
To open the Login Manager, choose Admin » Login Manager from within any Millennium module.  
 

 
 
 
Select the login you want to customize, and press Manager-controlled options button.  
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A screen similar to the following will appear. (This example is from Millennium Cataloging): 
 

 
 
 
Related options are grouped on tabs. Tabs and corresponding options vary between each module. You can customize the Manager-
controlled options for any login irrespective of what module you are logged in to, but you will only see the tabs and options that are 
associated with the module you are currently using. For example, if you are logged in to Millennium Cataloging, but want to customize 
a circulation login, you will not see the Due Slips, Sounds and other tabs that are specific to circulation logins. Likewise, you will not 
see the option Recent Patron history on the Setup tab for a Cataloging login. 
It is therefore recommended that you be logged in to the module for which you plan to customize logins.  
 
When a module is accessed from the Millennium control bar, Manager-controlled options are determined by the login that was originally 
used to access Millennium. Therefore it is recommended that all modules likely to be accessed by a certain login via the control bar - 
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either by way of a login that invokes the control bar, or via another module - have the appropriate options set for that login.  
 

You can, for example, launch a Millennium Circulation session and customize any login that is likely to access 
circulation, either directly or from the control bar, from that initial login. 

 
 
Tabs appear in each module as shown in this table:  
 

TABS MODULE

 ACQ ADM CAT CIRC ERM ILL SER

Data Exchange X X X X  X  

Departments      X  

Due Slips    X  X  

Edit X X X X X X X

Holds X X X X X X X

Images X X X X X X X

Login X X X X X X X

Modes X X X X X X X

Patron Display X   X  X  

Pickup Anywhere    X    

Printing X X X X X X X

Setup X X X X X X X

Sounds    X  X  

Tabs    X  X X

Web Master  X       

 
 
At the top of the tutorial pages you will find icons indicating the modules in which each option appear.  
 

 - this icon is used if the option appears in all modules. Module specific icons have different colors and the module name indicated 
on them, e.g.   
 
Some Manager-controlled options override corresponding system options, while others interact with them. For example, you will not 
see the Due Slips tab in Millennium Circulation if Circulation option Check-out: Print date due slips is set to NEVER. 
Relations between Manager-controlled options and specific System Options are discussed in the appropriate tutorial sections.  
 
Refer to section Working with the Login Manager for instructions on how to edit or copy Manager-controlled options.  
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DATA EXCHANGE

The Data Exchange tab looks similar to the following: 
 

 
 
 
This is where you define the import and export processes (load tables) that are available in the Data Exchange mode.  
 
NOTE: In Millennium Acquisitions, Data Exchange is a submode to Import Invoices.  
 
NOTE: The names of the processes that are available to you in Data Exchange are customized for each library.  
 
Processes listed under Displayed Processes are available for users of this login to import and export data in Data Exchange mode. To 
move a process, highlight it, then use left or right arrow to move it to the other list.  
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DEPARTMENTS | Login Manager

DEPARTMENTS

The Departments tab will look similar to this: 
 

 
 
 
Libraries with multiple ILL departments, also called units, can assign names to each department and specify the patron home library 
location code(s) served by each department. The initial setup for this is done by Innovative when Millennium Inter-Library Loans is 
installed on your system.  
 
For information about the ILL setup, refer to the Innovative Guide and Reference, Page# 100177 Setting Up ILL. If there is a need to 
change existing setup, contact Innovative.  
 
The Departments tab is used to limit the scope of logins. When you associate a login with a department, you limit the scope of the 
login to records and requests associated with that department, based on the home library location in the patron record.  
 

Requests from patrons with 'none' as their home library will appear in the Other department. 

 
 
NOTE: If your library does not have multiple ILL departments, the only option in the table will be Other.  
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DEPARTMENTS/CAMPUSES | Login Manager

DEPARTMENTS/CAMPUSES

 
 
 
Current selection at the top of the tab displays which department, if any, is currently selected for the login.  
 
Departments column - lists the departments that are defined for your system.  
 
Campuses column - lists the location codes associated with a specific department. To see a list of the campuses, i.e. locations, 
associated with a department, select the department name in the Departments column. The campuses/locations that belong to that 
department display in the Campuses column.  
 
To associate your login with a department:

●     Select the name in the Departments column
●     Press the Select button. Your selection displays in the Current selection field.

If you want the login to access requests from all campuses/departments/locations, choose the All button (or highlight the Other entry 
in the Departments column and press Select).  
 

Statistics on Filled and Cancelled requests will report only for the department associated with the login. To gather 
statistics for the whole system, use a login associated with All departments. 

 
 
NOTE: A change to this option does not take effect until you start a new session.  
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DUE SLIPS

The Due Slips tab contains the following options: 
 

 
 
 
NOTE: This tab will not appear if Circulation option Check-out: Print date due slips is set to NEVER.  
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MESSAGE TO PRINT ON DUE SLIP | Login Manager

MESSAGE TO PRINT ON DUE SLIP

 
 
 
This option allows you to include two lines of information on the bottom of date due slips. Both lines can contain a maximum of 40 
characters. Line 1 appears before Line 2.  
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PATRON INFORMATION ON DUE SLIP

 
 
 
This option determines what patron information the system includes on date due slips. 
If you select the Name button, the system includes the patron's name on date due slips.  
 

 
 
 
If you select the Barcode button, the system includes the patron's barcode number on date due slips.  
 

 
 
 
If you select the Neither button, the system includes the patron record number on date due slips.  
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DUE SLIP LAYOUT

 
 
 
You can customize your due slips by using this option. You can determine:

●     Which of the listed fixed- and variable-length fields are included on due slips
●     The order in which the fields appear
●     How many spaces are allotted for each field 

 
 
To add a field to the due slip:

1.  Double click and enter a number in its Slip Order cell. If more than one field has the same order number, the system 
warns you when you choose the OK button, and will not allow you to save until you have corrected one of the fields.

2.  Double click and enter the number of spaces it can occupy in its Width cell. Note that the Total field adjusts 
automatically. The number in the Total field represents the total number of spaces currently allocated for the due slip, 
including spaces between fields. The width of the due slip cannot exceed 130 spaces. If you allot more than 130 
spaces, the system warns you when you choose the OK button, and will not allow you to save until you have corrected 
the number.

If you print date due slips on a 40-column printer, Millennium prints each field on a separate line. The field width has to be adjusted to 
the printer width.  
 
To edit the value for an existing field, double click on the entry that you want to alter and re-key its value.  
 
To remove an entry, double click on it and press the <Delete> or <Backspace> key. Remove the values in both columns.  
 
Buttons: 
Use Defaults - return the table to its default settings (as seen on the image above). 
Reset to Previous Settings - return the table to its last saved form, i.e. the values that were specified when you last chose the OK 
button. 
Print Test Slip - print a test due slip. Note: you can print a test slip only for the login that you used to launch your current Millennium 
session. If you edit the settings for another login, Print Test Slip is disabled.  
 

 
 
 
NOTE: A change to this option does not take effect until you start a new session.  
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EDIT

The Edit tab contains the following options in most Millennium modules: 
 

 
 
 
Millennium Acquisitions and Administration look slightly different.  
 
Millennium Acquisitions: 
 

 
 
 
Millennium Serials: 
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USE WIZARD TO CREATE NEW RECORDS | Login Manager

USE WIZARD TO CREATE NEW RECORDS

 
 
 
With the Wizard turned on, when creating a new record you fill in boxes as specified by prompts in the new record template you have 
selected.  
 

 
 
 
If this option is not selected, you select a template and key directly into a record workform, without prompts.  
 

 
 
 
For information about adding new templates to the system, refer to the Innovative Guide and Reference, Page # 105825: Managing 
Templates for New Records  
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FIXED-LENGTH FIELD DISPLAY MODE | Login Manager

FIXED-LENGTH FIELD DISPLAY MODE

 
 
 
This option governs the display of the fixed-length fields.  
 
Show codes only 
Content will display as code only, and valid values are offered in code order. For example in the Language field you will see code eng, 
but not description English.  
 

 
 
 
Show descriptions only 
Content will display as description only, and valid values are offered in description order. For example in the Language field you will see 
description English, but not code eng.  
 

 
 
 
Show both codes and descriptions 
Content will display as both code and description, and valid values are offered in either order, depending on whether code or 
description is selected. For example in the Language field you will see eng English.  
 

 
 
 
NOTE: A change to this option does not take effect until you start a new session.  
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SELECTION LIST DISPLAY MODE | Login Manager

SELECTION LIST DISPLAY MODE

 
 
 
When you view the Selection List tab for an order record or view a particular title in Selection List mode, you can display copy 
information in a line view or a box view. This setting determines the default view for the login. However, regardless of the default 
setting, you can toggle between views while you are looking at the selection list information by right clicking on a line or a box.  
 
Selection List Display in Line mode: 
 

 
 
 
 
Selection List Display in Box mode:  
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ADD SUPPLEMENTS AND INDEXES

 
 
Issue boxes on the checkin card have a Public Note and a Staff Note: 
 

 
With this option you specify whether the Public Note or the Staff Note displays on the checkin card box.  
 
Public Note displaying:

The asterisk indicates there is another note. If you hover over the box both notes will 

display.

Staff Note displaying:

file:///C|/PROJECTS/TUTORIAL%20LoginManager%202008%20-%20UPDATES/print_options5_new01.html (1 of 2) [10/27/2008 11:05:27 AM]



DISPLAY WHICH BOX NOTE ON CHECKIN CARD | Login Manager

 
NOTE: This setting only affects the staff client. In the WebPAC, the Public Note will always display.  
 
For detailed information about box notes, refer to the Innovative Guide and Reference, Page # 100489: Overview of Checkin Card 
Fields.  
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HOLDS

The Holds tab contains the following options in all modules: 
 

 
 
 

Make sure the default matches your circulation policy. Do not make exceptions for any logins, unless there is a 
special reason. 

 
 
For further information about holds, refer to the Innovative Guide and Reference, Page # 100098: Placing Holds  
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ALLOW BIB LEVEL HOLDS ON BIBS WITH ONLY 1 ATTACHED ITEM

 
 
 
If this option is selected, staff are allowed to place a title-level hold on a bibliographic record, even if that record has only one attached 
item record.  
 
If this option is not selected, staff must place an ITEM-level hold when there is only one attached item record.  
 
NOTE: This option overrides Circulation Option Holds: Title level hold even if only one copy  
 

Rules for patron placed holds in the WebPAC are governed by the "Hold Level" section of Web Server option 
REQUEST. 
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ALLOW BIB LEVEL HOLDS ON BIBS WITH NO ITEMS AND NO ORDERS

 
 
 
If this option is selected, staff are allowed to place a title-level hold on a bibliographic record, even if that record has no attached item 
or order records.  
 
If this option is not selected, it is not possible to place a hold on a record that has no items or orders attached.  
 

To prevent a patron from placing title-level holds on a bibliographic record with no attached item or order records, 
when requesting from the WebPAC, set the BIBREQUEST Web Server option to "false". 
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SHOW HOLD ALERT DURING RECEIVING | Login Manager

SHOW HOLD ALERT DURING RECEIVING

 
 
 
If this option is selected, the system provides a message to alert staff of any title-level holds when receving an order using one of the 
following methods: 
 

●     Rapid Receive mode, Receive and Create items submode in Millennium Acquisitions
●     Rapid Receive mode, Rapid Update submode, Update Single Record option in Millennium Acquisitions
●     Manually updating the RDATE field on the Record tab in any module where you can access order records

 
 

 
 
 
Note that the alert message does not appear if staff receive the order via Rapid Update (Update Multiple Records option), or the 
Receive tab in Orders mode in Millennium Acquisitions or in another Millennium module.  
 
For additional information about receiving orders in Millennium Acquisitions, refer to the Innovative Guide and Reference, Page # 
100628: Receiving Acquisitions  
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LIMIT PICKUP LOCATIONS TO THOSE IN THE HOLD PICKUP LOCATIONS TABLE

 
 
 
If this option is enabled, staff will be offered a selection of pickup locations from the Hold Pickup Locations table when placing a hold. 
This table allows a library that has multiple locations defined within a single building, but only one hold pickup location in that building, 
to create a hold pickup location name to which all the location codes in the building are assigned.  
 

Make sure you have completed the setup of your Hold Pickup Locations table before you select this option, or staff 
may not be able to choose an appropriate pickup location. If this option is enabled and the Hold Pickup Locations 
table is empty, the system will not offer any pickup locations in the holds dialog. 

 
 
If this option is not selected, staff choose pickup locations from the Branch (location) codes table, i.e. all your location codes are listed.  
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DEFAULT NOT WANTED AFTER DATE | Login Manager

DEFAULT NOT WANTED AFTER DATE 

 
 
 
If you enter a number between 1 and 999 in this field, a default date displays in the Not Wanted After Date dialog when you place an 
Item-level or Title-level Hold. This default date is calculated by adding the number of days to the date you are placing the hold; for 
instance, if you enter 30 into the Default Not Wanted After Date field and you place a hold on 04-16-2008, the date displays as 05-16-
2008, i.e. 30 days later. Note that you can always edit the Not Wanted After date suggested by the system when placing holds. 

A maximum value of 365 is recommended for the Default Not Wanted After Date field. If the number is set to 0, no default Not Wanted 
After date is calculated.  
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IMAGES

The Images tab displays a list similar to the following (this example is from Millennium 
Acquisitions):

 

Navigation bar and 
corresponding 
default images (this 
example is from 
Millennium 
Acquisitions):

 

 
The files listed are those that define the graphic images that appear on the Millennium navigation bars and as default book jacket.  
 
Default book jacket image (displays when the title specific book jacket is not found): 
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Use the following steps to change an image file:

1.  Highlight the component you want to change and click on Set Resource.
2.  Click on Select to use one of the default images in Millennium. 
3.  Click on Import to use an external image file stored on the workstation or on the network. 

For detailed information about defining images, refer to the Innovative Guide and Reference, Page # 100023: Defining the Images that 
Display in the Navigation Bar.  
 
NOTE: A change to this option does not take effect until you start a new session.  
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IMAGES

The Login tab contains the following options in most modules:  
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EXIT APPLICATION ON KEYBOARD TIMEOUT | Login Manager

CLEAR INITIALS ON KEYBOARD TIMEOUT

 
 
 
If this option is selected, the system clears the current initials after the keyboard timeout period expires, and you are prompted to 
enter initials again. Note, however, that the application is not closed.  
 
The keyboard timeout is set from the Login Administration. Refer to the Innovative Guide and Reference, Page # 100310: Setting 
Keyboard Timeout Periods for details.  
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EXIT APPLICATION ON KEYBOARD TIMEOUT

 
 
 
If this option is selected, the system closes the application and releases the user license after the keyboard timeout period expires.  
 
The Clear initials on keyboard timeout and Exit application on keyboard timeout checkboxes may be selected in any combination to 
control the application's behavior when the keyboard timeout period expires. However, if Exit application on keyboard timeout is 
selected, Clear initials on keyboard timeout has no function, since the application will close anyway.  
 
If neither option is selected, the application will merely go back to default mode when the keyboard timeout period expires.  
 
If the login has no keyboard timeout set, the application will stay open on the screen where you leave it.  
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PROMPT FOR INITIALS ON STARTUP | Login Manager

PROMPT FOR INITIALS ON STARTUP

 
 
 
If this option is selected the system prompts you to set the initials at the beginning of a new session. If your library has multiple 
accounting/serials units, you will be prompted for initials at the beginning of the login process. If not, you will be prompted when the 
client has finished loading: 
 

 
 
 
If your library has multiple accounting/serials units, you will be placed in the unit associated with your initials.  
 
Note that if you enable this option, the system automatically disables the Associate initials and password with login option.  
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ASSOCIATE INITIALS AND PASSWORD WITH LOGIN/INITIALS TO ASSOCIATE WITH LOGIN

 
 
 
If this option is selected, the Initials to associate with login must be filled in to make the setting work correctly. The system will 
then automatically associate the login with the initials you enter here, and you will not be prompted to enter initials at the beginning of 
a session.  
 
Note that if you enable this option, the system automatically disables the Prompt for initials on startup option.  
 
INITIALS TO ASSOCIATE WITH LOGIN     
 

 
 
 
Millennium Circulation and Inter-Library Loans logins do not have an Associate initials and password with login checkbox. For 
these modules you associate initals with login by filling in the initials box only. If you fill in initials in the box, the system will 
automatically associate the login with the initials entered here, and there will be no prompt for initials at the beginning of a session.  
 
Note that if you enable this option, you need to disable the Prompt for initials on startup option, or the box will be cleared automatically 
and you will still be prompted for initials when you start a session.  
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MODES | Login Manager

MODES

The Modes tab displays a list similar to the following. The example is from Millennium Circulation: 
 

 
 
 
The content varies depending on the modes available on your system. Some options appear only if your library has acquired a certain 
product. For example the Homebound Report mode in the example above is available only if your library has the "Homebound Patron 
Services" product.  
 
The checkboxes you select govern which modes display for the login to access.  
 
NOTE: In Millennium Circulation, enabling/disabling Renew (No Patron) overrides the setting of Circulation option Renewals: Allow 
renewal by item barcode?  
 

If Circulation Desk mode is not checked in Millennium Circulation and Inter-Library Loans, the Tabs tab is 
automatically disabled. 

 
 
Modes can be accessed from the navigation bar, or from the Go menu.  
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When you start a new session or clear your initials, your Millennium module switches to its default mode. Millennium 
uses the first enabled mode that appears in the navigation bar or Go menu as its default mode. 

 
 
NOTE: Changes do not take effect until you start a new session.  
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PATRON DISPLAY | Login Manager

PATRON DISPLAY

The Patron Display tab contains the following options in Millennium Circulation and Millennium Inter-Library Loans: 
 

 
 
 
The Show patron photo option will only be included if your library has acquired the Patron Images product.  
 
In Millennium Acquisitions the tab looks different: 
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The options determine the information that Millennium displays in the upper part of the screen for patron records in the following 
modes: 
 
Millennium Circulation - Circulation Desk mode. 
Millennium Inter-Library Loans - Circulation Desk and Enter Requests modes. 
Millennium Acquisitions - Recommend mode, Selectors submode.  
 

 
 
 
NOTE: In Millennium Circulation these options override Circulation options Display patron demerits and blocked until date and Check-
out: display patron address.  
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BRIEF DISPLAY | Login Manager

BRIEF DISPLAY

 
 
 
If this option is selected, the patron record's NAME, BARCODE, NOTE, P TYPE, CL RTRND, and EXP DATE fields will display.  
 
Additionally, if your library has acquired PCODE4, Millennium will include that field in the display.  
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BRIEF DISPLAY W/ADDRESS | Login Manager

BRIEF DISPLAY W/ADDRESS

 
 
 
If this option is selected, the patron record's NAME, BARCODE, NOTE, ADDRESS, TELEPHONE, P TYPE, CL RTRND, and EXP DATE fields 
will display.  
 
Additionally, if your library has acquired PCODE4, Millennium will include that field in the display.  
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CUSTOM DISPLAY | Login Manager

CUSTOM DISPLAY

 
 
 
When this option is selected, you can create a customized list of fixed- and variable-length fields from the patron record to display in 
Circulation Desk mode. (In Millennium Inter-Library Loans also in Enter Requests mode)

●     The Displayed Fields list shows the fields that Millennium will display, and the order in which they will display. 
●     The Available Fields list shows the other fields Millennium can display. 

Note that Millennium will not include the PAT IMAGE or PIN variable-length fields in either list, regardless if they are enabled in your 
system.  
 
To move a field from one list to the other: 

1.  Select the field to move. 
2.  Choose the left or right arrow button. 
3.  Millennium moves the field to the other list. 

To reorder the display of fields: 

1.  In the Displayed Fields list, select the field to reorder. 
2.  Choose the up or down arrow button. 
3.  Millennium moves the field up or down in the list, one step at a time.
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FULL DISPLAY | Login Manager

FULL DISPLAY

 
 
 
If this option is selected, the patron record's NAME, BARCODE, ADDRESS, ADDRESS2, PCODE1, PCODE2, PCODE3, P TYPE, EXP DATE, 
CUR CHKOUT, MBLOCK, CL RTRND, MONEY OWED and NOTE fields will display.  
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SHOW PATRON PHOTO | Login Manager

SHOW PATRON PHOTO

 
 
 
NOTE: The option to display patron photographs will only appear if your library has acquired the Patron Images product.  
 
If this option is enabled, patron photos will appear as follows: 
Millennium Circulation - Circulation Desk, Check out to remote site, Check out to visiting patron, and Count Use - 
Photocopies by Patron modes, as applicable. 
Millennium Inter-Library Loans - Circulation Desk and Enter Requests modes.  
 

 
 
 
If the system cannot find a photograph associated with the patron record, a dummy image displays.  
 

 
 
 
For information on how to configure the system to display patron photographs, refer to the Innovative Guide and Reference, Page # 
105363: Patron Images  
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PICKUP ANYWHERE | Login Manager

PICKUP ANYWHERE

The Pickup Anywhere tab contains the following option: 
 

 
 
 
NOTE: This tab will only appear if your site belongs to a Local Server that has acquired the Pickup Anywhere for INN-Reach product.  
 
The Central System Administrator assigns every Pickup Anywhere location a unique key. To access Pickup Anywhere mode and the 
Pickup Anywhere database on the INN-Reach Central Server, you must use this option to assign the key to your login.  
 
If your Local Server belongs to more than one INN-Reach System, the Pickup Anywhere tab also contains an INN-Reach Central 
Machine drop-down list, containing the name of each INN-Reach Central Server to which your Local Server contributes.  
 
For further information, refer to the Innovative Guide and Reference, Page # 105482: Pickup Anywhere for INN-Reach  
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PRINTING | Login Manager

PRINTING

The Printing tab displays a screen similar to the following: 
 

 
 
NOTE: Settings for printing will not be meaningful if no printers are associated with the login. 
If a login has not been assigned any printers, the system displays a message when the login attempts to print or set the current 
printer: No printers are available. 
Refer to the Innovative Guide and Reference, Page # 106351: Millennium Login Administration for information about associating 
printers with a login.  
 

Your Available Printers in the Login Administration may include several printers defined as "local" or "attached". Only 
one of these needs to be associated with the login to enable the Local Printer option in Millennium. Local printers 
are attached to the Millennium workstation, either through a direct connection (e.g. a parallel or USB printer port) or 
over a local-area network. The system will use your workstation's printer settings to find the physical printer(s).  
 

 

 
 
Printing can be done to a local printer, a system printer, to email or to file. Note the distinction between the physical printers used, and 
the printing categories that Millennium uses to define different types of print jobs.  
 
For general information, refer to the Innovative Guide and Reference, Page # 104056: Printing in Millennium.  
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PRINT RECEIPTS FOR CHECKED-IN ITEMS | Login Manager

PRINT RECEIPTS FOR CHECKED-IN ITEMS

 
 
 
If this option is checked, the system marks the Print receipt check box each time the Check In tab is shown.  
 

 
 
 
A receipt of the checked-in items will print automatically after you have finished the check-in procedure and choose to Close the 
patron record. To disable the receipt printing temporarily, uncheck the box before you start checking in items from a new patron.  
 
If this option is not selected, the Print receipt check box will not be checked by default. To enable check-in receipt printing 
temporarily, check the box before you start checking in items from a new patron.  
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ALLOW LABEL PRINTING | Login Manager

ALLOW LABEL PRINTING

 
 
 
This setting controls the ability to print spine-, pocket- and routing labels during serials checkin.  
 
NOTE: Printing of monographic labels is not governed by this option, but is always available for users with appropriate authorization.  
 
To enable serials checkin label printing, the following must be true: 

●     Allow label printing checkbox in Login Manager is checked. 
●     LABEL TYPE fixed-length field in the holdings/checkin record is set to a value other than "n" and/or the record has a Routing List 

associated with it. 

 
 
Example 1: Allow label printing is enabled, and LABEL TYPE fixed-length field in the holdings/checkin record is set to a value other than 
"n":  
 

 
 
Example 2: Allow label printing is enabled, and holdings/checkin record has a routing list associated with it:  
 

 
 
Example 3: Allow label printing is enabled, LABEL TYPE fixed-length field in the holdings/checkin record is set to a value other than "n", 
and the record has a routing list associated with it:  
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Leave this setting unchecked if you want to disable serials checkin label printing for the login.  
 
For additional information, refer to the Innovative Guide and Reference, Page # 100434: Printing Serials Labels during Check-in  
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PRINTING DEFAULTS | Login Manager

PRINTING DEFAULTS

 
 
 
These options allow you to specify how the system remembers choice of printer and printer settings.  
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LAST USED ON WORKSTATION FOR LOGIN | Login Manager

LAST USED ON WORKSTATION FOR LOGIN

 
 
 
Use this option if you want the system to store the choice of printer that is made while someone uses the login on a particular 
workstation. With this option enabled, the choice of printer for each Printing category is stored on the workstation and will be saved 
and re-used for the login on that workstation. Note, however, that if the same login is used on a different workstation, the choice of 
printer(s) may be different. 
Each login on a particular workstation can have its own choice of printer(s), i.e. if the same workstation is used to run different logins 
(e.g. for different modules), different printers can be used.  
 
Note about Local Printers: If the default printer is a local printer, the options you set for that printer are stored on the workstation 
as well. Many more user-configurable settings are available for local printers than for any other printer type (e.g. for a system printer). 
The options that you may choose are based on the capabilities of the printer. For example, if the printer cannot print in color, the 
Color button on the Appearance tab will not be available.  
 
When you choose a local printer for the first time or change the printer via File » Select Printer, Millennium presents a dialog with 
four tabs:

●     General: This tab allows you to select any of the local printers available to your workstation, the range of pages to print, and 
the number of copies to print.  
 

 
 
 

●     Page Setup: This tab allows you to specify the paper size, direction of printing, and page margins. You can choose only those 
options that are supported by the printer.  
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LAST USED ON WORKSTATION FOR LOGIN | Login Manager

 
 
 

●     Appearance. This tab allows you to specify special printer features, such as color printing and non-standard paper-handling, if 
the printer supports them.  
 

 
 
 

●     Format. This tab allows you to specify text or graphic printing and page layout for each. The Text (narrow) option is for 40-
column printing.  
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If the Last used on workstation option is selected, the choice of local printer and its settings are remembered when modified, and 
stored on the workstation where the change took place. Otherwise, if the Use login defaults option is selected, these options are not 
retained between sessions.  
 
If staff wants to select another printer than the one that is currently used as the default on the workstation, they can do so from the 
File » Select Printer menu. Note that the printer that was last used during a session will be the default the next time someone logs in 
with the same login.  
 
NOTE: Support for local printers and access to their capabilities is based on the workstation operating system's support for the 
particular printer(s) available to your workstation. This means that manufacturer-specific printer drivers must be installed on the 
workstation before Millennium can access the printers.  
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USE LOGIN DEFAULTS | Login Manager

USE LOGIN DEFAULTS

 
 
 
When you select Use login defaults, the selection of physical printer or local printer settings discussed in the previous step, are not 
retained between the sessions. The user can modify settings during the session when choosing a local printer, but the system does not 
save the changes after the user logs out.  
 
The Use login defaults option allows you to set general printing defaults for the login. These settings are stored on the server, 
making them available to the login on whichever workstation is used. Click on the Login Defaults button and the system presents the 
settings.  
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PRINTING CATEGORIES | Login Manager

PRINTING CATEGORIES

 
 
 
Wherever you have an option to print in Millennium, the type of printing that will take place is defined by the system, as follows: 
 
Standard printer - browse displays, records, tables, files, lists 
Label printer - spine & pocket labels for monographs and serials, routing slips 
Receipt printer - receipts, e.g checkout/checkin receipts, fine payments 
Form printer - circulation notices, claims, purchase orders 
 
 
Note that the table above reflects the four categories of printing in Millennium. You do not necessarily need separate, designated 
printers for all purposes. For example, you can use the same physical printer to print browse displays as you do for printing receipts.  
 
Print icons and most Print buttons will display what type of printing the system will perform in the current situation, if you place the 
cursor over it.  
 

 
 
 
This information is also displayed in print dialogs.  
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NOTE: Print Templates is a separate printing class that takes precedence when it is enabled for a certain output type. The setup is 
managed in the Print Templates tab in Settings.  
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SELECT LOCAL PRINTER ON STARTUP | Login Manager

SELECT LOCAL PRINTER ON STARTUP

 
 
 
If this option is selected, the default printer for the printing category in question is automatically set to Local Printer when the login 
starts Millennium. Staff will be prompted to choose settings for the printer, including choice of printer if more than one is accessible, 
the first time of printing during the session: 
 

 
 
 
NOTE: This option will only work if a "local" or "attached" printer is also associated with the login.  
 
If this option is not selected, you will be prompted to choose a printer at the time of printing. The types of printers that appear in the 
Select Printer dialog are those that have been assigned to the login.  
 

Whether or not you have this option selected, for most Millennium printing functions you can choose a printer for the 
current session from the File » Select Printer menu. 
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ENABLE DIRECT TEXT PRINTING | Login Manager

ENABLE DIRECT TEXT PRINTING

 
 
 
This option determines whether print jobs sent to the Local Printer are output as text or as graphics. With direct text printing, the 
system outputs a stream of characters. Direct text printing is faster and easier to read, but cannot produce graphics. The system 
checks this option's value each time you print, so you may change the setting between print jobs.  
 
Notes:

●     Every printing category shares the same Direct Text Printing Options: Printer for direct text printing is only 40 columns 
wide and Number of lines to eject after printing. The direct text printing options selected for the login will apply for all 
print jobs (standard, receipt, label, form) sent to the local printer.

●     If the attached local printer is a 40-column printer, also check the Printer for direct text printing is only 40 columns wide 
option. 

 
 

Direct text printing is typically used for receipt printers, directly attached to Circulation Desk workstations. 

 
 
PRINTER FOR DIRECT TEXT PRINTING IS ONLY 40 COLUMNS WIDE  
 

 
 
 
Select this option if your attached local printer is only 40 columns wide. The system will allow you to select this option only if the 
Enable direct text printing option is checked.  
 
NUMBER OF LINES TO EJECT AFTER PRINTING  
 

 
 
 
Specify the number of blank lines (up to 20) that the system should leave after each print job. The system will allow you to select this 
option only if the Printer for direct text printing is only 40 columns wide option is checked.  
 
NOTE: This option overrides Circulation option Number of lines between receipts for books.  
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SETUP | Login Manager

SETUP

The Setup tab contains various options, depending on module. Some modules only have a few basic options. The example is from 
Millennium Cataloging: 
 

 
 
 
Other modules have many specific options, like Millennium Serials: 
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ADD MESSAGE AT CHECKOUT | Login Manager

ADD MESSAGE AT CHECKOUT

 
 
 
This option controls whether the Add Message button is displayed in the Check Out tab of Circulation Desk mode. Displaying the 
button allows authorized users to add a MESSAGE variable-length field to an item after checkout. The item messages display whenever 
the item is retrieved during a circulation transaction, e.g. at checkout, checkin or renewal.  
 

 
 
 

 
 
 
For further information about this function, refer to the Innovative Guide and Reference, Page # 105953: Adding Messages at 
Checkout.  
 
NOTE: A change to this option does not take effect until you start a new session.  
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HIDE THE BIBLIOGRAPHIC RECORD IN THE INVOICE DISPLAY | Login Manager

HIDE THE BIBLIOGRAPHIC RECORD IN THE INVOICE DISPLAY

 
 
 
This option determines, for the default setting, whether the system maximizes the invoice display or splits the invoice display with a 
bibliographic record/search display. In either case, you can change this display interactively from the Invoice toolbar using the Show 
Bib, Show Invoice and Both options.  
 

The bibliographic record display is useful when you do not have the order record number available during invoice 
processing since it allows you to retrieve the order by searching the regular indexes. When the bibliographic window 
is hidden, you must retrieve the record by order number. 

 
 
With this option checked, the bibliographic window is hidden: 
 

 
 
 
 
 
If this option is not checked, both the invoice and the bibliographic window will display: 
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LOGIN CAN EDIT PREFERENCES | Login Manager

LOGIN CAN EDIT PREFERENCES

 
 
 
This option controls whether users of the login can change its Preferences using menu option Edit » Preferences.  
 

 
 
 

The Login can edit preferences setting is designed to allow users who are not authorized to access the Login 
Manager the ability to customize their display and editor preferences. If your library is using shared logins (e.g. all or 
some of the catalogers are sharing the same login name), it is not recommended to select this option, since the 
changes a user can make to the Preferences will apply to all other users of that login. 

 
 
If this option is not selected the user must be authorized for function 187 (Login Manager) to edit the Preferences from the Login 
Manager.  
 
Refer to the Preferences section of this tutorial for more information about the settings in Preferences.  
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PROMPT TO GENERATE CLAIMS DURING CHECKIN | Login Manager

PROMPT TO GENERATE CLAIMS DURING CHECKIN

 
 
 
This setting determines whether the system prompts the user to claim late issues when exiting the Card tab after checking in serials.  
 
When Prompt to generate claims during checkin is enabled: 
 
1. In checkin mode, click on Close: 
 

 
 
 
2. The following message box will appear if there are late issues on the card: 
 

 
 
 
3. Answering Yes brings up the Claim screen: 
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This way of claiming late issues can be used as a complement to the standard method applied in Claiming mode.  
 

close window

file:///C|/PROJECTS/TUTORIAL%20LoginManager%202008%20-%20UPDATES/print_options13_12.html (2 of 2) [10/27/2008 11:05:36 AM]

http://csdirect.iii.com/manual/gmser_claim_search_in_mode.html
javascript:window.close()


RECENT PATRON HISTORY | Login Manager

RECENT PATRON HISTORY

 
 
 
The number entered in the box determines how many previous patrons the system remembers in menu File » Recent Patrons in 
Circulation Desk mode. The maximum number is 26.  
 
Entries display with most recent record at the bottom of the list. Each patron name is preceded by an underlined letter, which could be 
used as a keyboard shortcut to retrieve the record again.  
 

 
 
 
NOTE: If a patron record is retrieved from a search more than once within the number set, it retains its initial position in the history 
list.  
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RECENT RECORD HISTORY | Login Manager

RECENT RECORD HISTORY

 
 
 
The number entered in the box determines how many previous records the system remembers in menu File » Recent Record. Entries 
display with most recent record at the top of the list.  
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RECENT SEARCH HISTORY | Login Manager

RECENT SEARCH HISTORY

 
 
 
The number entered in the box determines how many previous searches the system remembers in menu File » Recent Search. 
Entries display with most recent search at the top of the list.  
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REMOVE CLAIMS RETURNED NOTES FOR CHECKED-IN ITEMS | Login Manager

REMOVE CLAIMS RETURNED NOTES FOR CHECKED-IN ITEMS

 
 
 
If this option is selected, the system removes the claims returned notes in the patron and item records when the item is checked in. If 
the option is not selected, the claims returned notes remain in the records regardless of check-in.  
 
NOTE: A change to this option does not take effect until you start a new session.  
 
For detailed information about the Claim Returned function, refer to the Innovative Guide and Reference, Page # 100067: Claiming 
Items Returned  
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RESTRICT RECEIVE AND CREATE ITEMS TO LOCATIONS SERVED | Login Manager

RESTRICT RECEIVE AND CREATE ITEMS TO LOCATIONS SERVED

 
 
 
If this option is selected, the user can only receive copies with locations included in the Locations Served table associated with the 
user's initials. In Rapid Receive, Receive and Create Items submode, or on the Receive tab in Orders mode, the display will 
suppress copies where the location code is not included in the Locations Served entry associated with the user's initials.  
 
In the example below, locations "xlav" and "xlb" belong to different Locations Served.  
 
If this option is not enabled, the user can select and receive any copy: 
 

 
 
 
If the option is enabled, the user can only view and receive copies belonging to the Locations Served entry associated with the user's 
initials: 
 

 
 
 
NOTE: A change to this option does not take effect until you start a new session.  
 
For information about associating initials with a Locations Served, refer to the Innovative Guide and Reference, Page # 106327: 
Passwords and Authorizations  
 
For details about receiving orders, refer to the Innovative Guide and Reference, Page # 100629: Receiving Order Records and Creating 
Items  
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SHOW "CLAIM ALL" BUTTON IN CLAIMING MODE | Login Manager

SHOW "CLAIM ALL" BUTTON IN CLAIMING MODE

 
 
 
This setting determines whether the system displays the Claim All button in the Claiming mode of Millennium Serials and the Claim/
Cancel mode of Millennium Acquisitions.  
 

 
 
 
The Claim All button allows all orders or all late issues for holdings/checkin records in a given range to be automatically found and 
claimed with a single mouse-click.  
 
The Claim All option provides a fast and efficient way of claiming serials or orders but with less control since the claim decision is 
made globally for a given range of records rather than on a title-by-title basis.  
 
NOTE: Unwanted claims can be reviewed and removed from the list in Send mode, before claims are sent to the vendor.  
 
For additional information, refer to the Innovative Guide and Reference, Page # 100452: Claiming Serials and Page # 100651 Claiming 
and Cancelling Orders.  
 
NOTE: A change to this option does not take effect until you start a new session.  
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SHOW AMOUNT OWED IN FINES TAB | Login Manager

SHOW AMOUNT OWED IN FINES TAB

 
 
 
If this option is selected, the system displays the amount of money owed by the patron in the Fines tab. This value is contained in the 
patron record's MONEY OWED field.  
 

 
 
 
If this option is not selected, no amount will display in the Fines tab.  
 

 
 
 
NOTE: A change to this option does not take effect until you start a new session.  
 

In either case, the Fines tab will be red - or other color defined in Preferences - if the amount owed is greater than 
that set in Circulation option Check-out: Display fines if money owed exceeds.
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ADD SUPPLEMENTS AND INDEXES | Login Manager

ADD SUPPLEMENTS AND INDEXES

 
 
 
This setting determines whether the system allows you to use separate definitions for serial issues, supplements, and indexes. If your 
library chooses not to use separate definitions, all pieces of a serial are treated as issues.  
 
If your library chooses to utilize this distinction, Millennium Serials will store the different types of pieces in different MARC-tagged 
fields and allow you to define separate checkin card parameters for the issues, supplements, and indexes of each serial.  
 

For consistency reasons, it is recommended that you enable or disable the option to use supplements and indexes for 
all logins. 

 
 
With this setting enabled, the checkin card maintenance options are affected as follows: 
 

●     Creating checkin cards - You define separate card parameters (e.g. frequency and cover date) for issues, supplements, and 
indexes. 

●     Editing checkin card parameters - You edit the card parameters (e.g. frequency and cover date) for issues, supplements, 
and indexes separately. 

●     Adding or inserting checkin card boxes - Millennium Serials has separate options for adding issues, supplements, and 
indexes. 

●     Editing holdings (LIB HAS fields) - The Holdings tab has separate entries for issues, supplements, and indexes. 

The MARC 21 holdings fields for issues, supplements and indexes in holdings/checkin records are: 
 

Piece Type Defined by Stored in Description

Issues 853 field 863 field The regular unit of the title

Supplements 854 field 864 field Pieces published periodically to supplement issues

Indexes 855 field 865 field Pieces that contain an index for the publication 

 
 
If the setting is disabled, supplements and indexes will be defined by an 853 field and stored in an 863 field, just like the regular 
issues.  
 
If the setting is disabled, the user has to annotate a regular issue box with the information about indexes and supplements, e.g. create 
a separate box with the text "Supplement" or "Index" in the Box Note. Another approach would be to insert a Box Note saying 
"Includes index" or "Includes Supplement" on an existing issue box.  
 
For additional information about how Millennium stores issues, indexes and supplements, refer to the Innovative Guide and Reference, 
Page # 100417: Issues, Supplements, and Indexes  
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SHOW POP UP FOR PRINT PULL SLIP | Login Manager

SHOW POP UP FOR PRINT PULL SLIP

 
 
 
This setting determines whether the system displays the Print Pull Slip to Bind dialog when you print pull slips. This dialog allows the 
user to enter a Note on the pull slip. If this option is unchecked, the system does not display the Print Pull Slip to Bind dialog.  
 
When Show Popup for Print Pull Slip option is checked: 
 
1. In Binding mode, retrieve a record and click on Print Pull Slip button: 
 

 
 
 
2. The following dialog box appears: 
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SHOW PREVIEW OF POSTING PRINTOUTS | Login Manager

SHOW PREVIEW OF POSTING PRINTOUTS

 
 
 
Select this option to display a popup during posting that will show a preview of the posting printouts. If you uncheck this option, the 
posting registers will print but not display on the screen during posting.  
 
If Show preview of posting printouts is selected a series of popups will display, and you have to press OK to continue to the next 
step.  
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SHOW RECORD NUMBER IN BRIEF RECORD DISPLAY | Login Manager

SHOW RECORD NUMBER IN BRIEF RECORD DISPLAY

 
 
 
If this option is selected, the Millennium record number displays above the brief display of a record at the top of browse displays.  
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TAKE ITEM LOCATION FROM CHECKIN RECORD | Login Manager

TAKE ITEM LOCATION FROM CHECKIN RECORD

 
 
 
Select this option to automatically assign the location in the holdings/checkin record to an item created during check-in. Otherwise, the 
item's location will be the default location specified in the item record template.  
 
TURN OFF VALIDITY CHECKING FOR BARCODES     
 

 
 
 
This option will only appear if you have barcode validity checking enabled.  
 
If you select this option barcode validity checking is disabled when you check in or check out items using Millennium Interlibrary Loans 
or Circulation.  
 

Checking this option can help prevent conflicts when using non-standard barcode numbers to circulate non-local INN-
REACH or ILL items (e.g. the supplier's barcode number). 
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USE 1st ORDER RECORD WHEN CLAIMING | Login Manager

USE 1st ORDER RECORD WHEN CLAIMING

 
 
 
Select this option to automatically associate a claim with the first attached order record. If you do not select this option, order records 
are not automatically associated with claims.  
 
When an order record is associated, the last PAID field in the order record is displayed on the Card tab in the Claim function so that 
you can verify that the vendor has received payment for the serial.  
"Last payment" shows information from the PAID field in the order record, e.g. last paid amount and the payment date or a "not paid" 
note if no payments have been recorded. Clicking on the order record number/Last payment link brings up the order record.  
 

 
 
 
Regardless of this setting, the user can create or change the order record link manually by editing the Card Parameters.  
 
For additional information, refer to the Innovative Guide and Reference, Page # 100457: Modifying Order records While Claiming.  
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USE THE FUND NAME INSTEAD OF CODE IN THE FUND HIERARCHY DISPLAY | Login Manager

USE THE FUND NAME INSTEAD OF CODE IN THE FUND HIERARCHY DISPLAY

 
 
 
This setting determines whether the fund name or the code displays on the tree of funds and in fund reports.  
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USE THE VENDOR NAME INSTEAD OF CODE IN THE VENDOR HIERARCHY DISPLAY | Login Manager

USE THE VENDOR NAME INSTEAD OF CODE IN THE VENDOR HIERARCHY DISPLAY

 
 
 
This setting determines whether the vendor name or the vendor code displays in vendor hierarchies.  
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ALLOW ITEM CREATION | Login Manager

ALLOW ITEM CREATION

 
 
 
This setting determines whether the user can create item records for serial issues as part of the check-in procedure. With this setting 
enabled, the Create item checkbox will display on the Card tab.  
 

For serials where an item should always be created as part of the check-in procedure, make sure the card parameter 
Create item during check-in is checked. The Create item checkbox will then be checked by default. Edit the card 
via Tools » Card Menu » Edit Card. 

 
 
With Allow item creation disabled, the Create item checkbox will not display on the Card tab. Regardless of this setting, the user 
can create items after the issue has been checked in by using the Create Item for Box option on the Box Menu.  
 
Example 1: When Allow item creation is enabled, clicking on the Check In button with the Create item box marked will check in 
the issue and automatically prompt the user for the item record data.  
 

 
 
 
Example 2: When the Allow item creation setting is disabled, the Create item box does not display on the Card tab. If there is a 
need to create an item record, the user can optionally create the item for the issue after it has been checked in, by using the 
corresponding Box Menu option.  
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ALWAYS SHOW CHECK IN DIALOG | Login Manager

ALWAYS SHOW CHECK IN DIALOG

 
 
 
Select this option to always display the check-in dialog when checking in serials. This option is useful if issue enumeration and cover 
dates require frequent updating, or if issue level notes or URL's need to be inserted on a regular basis.  
 
Example 1: Always show check-in dialog enabled:  
 
1. Click on Check In button: 
 

 
 
 
2. Check-in dialog appears. Enter data in the fields as required and click OK to complete:  
 

 
 
 
3. Box status is changed to ARRIVED:  
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Example 2: Always show check-in dialog disabled: 
 
1. Click on Check In button: 
 

 
 
 
2. Box status is changed to ARRIVED without the dialog appearing: 
 

 
 
 
Note 1: Regardless of this setting, the user can always call up the check-in dialog on demand, by double clicking on the issue box or 
by using the Tools |Box Menu |Modify Boxes Individually option.  
 
Note 2: Regardless of this setting, the check-in dialog always displays if the issue box lacks a Cover date or Enumeration level values. 
This is a reminder for the user to add those values to the box.  
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ALWAYS SHOW CHECK IN DIALOG DURING SISAC CHECKIN | Login Manager

ALWAYS SHOW CHECK IN DIALOG DURING SISAC CHECKIN

 
 
 
If your library has the optional SISAC (previously known as SICI) barcode searching feature this option will display on the Setup tab. 
SISAC checkin means retrieving the bibliographic and attached holdings/checkin record by scanning the SISAC barcode printed on the 
journal.  
 
Select this option to always display the check-in dialog when performing SISAC check-in of serials.  
 
Example 1: Always show check-in dialog enabled: 
 
1. Click on Check In button: 
 

 
 
 
2. Check-in dialog appears. Enter data in the fields as required and click OK to complete: 
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ALWAYS SHOW CHECK IN DIALOG DURING SISAC CHECKIN | Login Manager

 
3. Box status is changed to ARRIVED:  
 

 
 
 
 
 
Example 2: Always show check-in dialog disabled: 
 
1. Click on Check In button:  
 

 
 
 
2. Box status is changed to ARRIVED without the dialog appearing: 
 

 
 
 
Note 1: Regardless of this setting, the user can always call up the check-in dialog on demand, by double clicking on the issue box or 
by using the Tools |Box Menu |Modify Boxes Individually option.  
 
Note 2: Regardless of this setting, the check-in dialog always displays if the issue box lacks a Cover date or Enumeration level values. 
This is a reminder for the user to add those values to the box.  
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COLLECT MONEY FOR MULTIPLE PATRONS | Login Manager

COLLECT MONEY FOR MULTIPLE PATRONS

 
 
 
By default, when you check in an item for a patron in the Check In tab in Circulation Desk mode, Millennium clears the Total box of 
fines the previous patron accumulated. That is, the amount is set back to zero as soon as a new patron checks something in, even if 
you don't Close the current record.  
 

 
 
 
If this option is selected, Millennium continues to display the fines accumulated by previous patrons. This allows you to collect fines for 
multiple patrons, e.g. for a family.  
 
To clear the Total box before you scan an item, click on the Close button.  
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DEFAULT "COPY EPRICE TO ITEM" | Login Manager

DEFAULT "COPY EPRICE TO ITEM"

 
 
 
This option is used when receiving orders and creating items from the Receive tab in the Orders mode and in Rapid Receive mode, 
Receive and Create Items sub-mode. If this option is selected, the Estimated price (EPRICE) value from the order record is 
automatically copied to the PRICE field in the item record that is created in the process.  
 
DEFAULT RECEIVE DATE TO TODAY'S DATE    
 

 
 
 
This option allows you to automatically set the Receive date (RDATE) to today's date when you are receiving items in Rapid Receive 
mode, Receive and Create Items sub-mode. When this option is not checked, the default RDATE date is blank. In either case, you 
can key a new date manually when receiving.  
 
For details about receiving orders, refer to the Innovative Guide and Reference, Page # 100629: Receiving Order Records and Creating 
Items  
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ENABLE WEAK BINDING | Login Manager

ENABLE WEAK BINDING

 
 
 
This setting determines how the system searches for issues to bind in Binding mode.  
 
With Enable Weak Binding unchecked, the binding method used by Millennium Serials searches for a Unit of binding in which all of 
the issues, supplements, and indexes have a Status of ARRIVED or PARTIAL. This is the default method.  
 
If you have checked the Enable Weak Binding option, Millennium Serials employs a less stringent method of determining which 
issues, supplements, and indexes are bindable. The system searches for a Unit of binding in which at least one of the boxes has a 
Status of ARRIVED, PARTIAL, TO BIND, BIND PREP, or BOUND.  
 
Regardless of this setting, the user can always override the pre-selected issues and manually select the issues to bind.  
 
For additional information about how Millennium decides which issues are bindable, refer to the Innovative Guide and Reference, Page 
# 100443: Determining Which Issues to Bind  
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FOR CHECKIN BOUND, GET ITEM LOCATION FROM CHECKIN | Login Manager

FOR CHECKIN BOUND, GET ITEM LOCATION FROM CHECKIN

 
 
 
Select this option to automatically assign the location code from the holdings/checkin record to an item created during check-in of 
bound issues. Otherwise, the item's default location will be the location specified in the item record template.  
 
For additional information, refer to the Innovative Guide and Reference, Page # 100450: Checking in Bound Issues  
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RECENT CHECK-IN HISTORY | Login Manager

ADD SUPPLEMENTS AND INDEXES

 
 
The number entered in the box determines how many checked-in items (displayed as the names of the patrons who most recently 
checked in the items) the system remembers in menu File » Recent Check-Ins in Circulation Desk mode. The maximum number is 
26.  
 

 
 
 
Entries display with most recent record at the bottom of the list. Each patron name is preceded by an underlined letter, which could be 
used as a keyboard shortcut to retrieve the record again. If a patron checks in several items within the number set, the name appears 
once for every checked in item.  
 
NOTE: This option is available only in Circulation Desk mode, not in Check-In mode.  
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SOUNDS | Login Manager

SOUNDS

The Sounds tab has a list similar to the following: 
 

 
 
 
Sound clips are used together with some functions, e.g. as a complement to patron or item warning messages.  
 
Disable sounds - select this option to turn off sounds altogether.  
 
Use default beep - select this option if you want to use your workstation's own default sounds.  
 
Use customized sounds - select this option to use the sound clips that are defined by the files in the list. If you use customized 
sounds, you can still disable a single sound type by selecting its name in the list, press Set Resource and choose (none) from the top 
of the list that appears.  
 
Set Resource can also be used to test sounds (use button Play Sound), change sound clips and Import new sound clips.  
 
NOTE: Disable sounds or enabling Use default beep will take effect immediately. Enabling Use customized sounds or changing a 
sound clip do not take effect until you start a new session.  
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TABS | Login Manager

TABS

The Tabs tab has a list similar to the following. The example is from Millennium Circulation: 
 

 
 
 
The content may vary depending on the products your library has acquired. For example, in the example above, the Inter-Library 
Loans tab is available only if your library has the Inter-Library Loans module.  
 
In Millennium Circulation and Inter-Library Loans:  
The checkboxes you select govern which tabs the login may access in Circulation Desk mode. The example above would trigger the 
following screen: 
 

 
 
 
A tab can also be accessed from another mode, using the Go » Circulation Desk menu.  
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TABS | Login Manager

 
 
 

In Millennium Circulation and Inter-Library Loans the Tabs tab will not display if the Circulation Desk mode is 
disabled on the Modes tab. 

 
 
In Millennium Serials: 
The checkboxes you select govern which tabs the login may access in the following modes: Serials Check-in, Binding, Claiming, To 
Bindery and Check In Bound. If all these modes are disabled on the Modes tab, the Tabs tab will not display.  
 
NOTE: Changes do not take effect until you start a new session.  
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WEB MASTER | Login Manager

WEB MASTER

The Web Master tab looks similar to the following: 
 

 
 
 
The Web Master mode enables you to access the files that support your WebPAC. 
This is where you define the import and export processes that are available in the Web Master mode.  
 
Processes listed under Displayed Processes are available for users of this login in Web Master mode. To move a process, highlight it, 
then use left or right arrow to move it to the other list. 
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INTRODUCTION TO PREFERENCES | Login Manager

INTRODUCTION TO PREFERENCES

Preferences control the appearance of the module for a particular login, e.g. colors and fonts. Changes made to the Preferences will 
affect all users of the login.  
 
Preferences are set from the Login Manager. To access the Login Manager, you must be authorized for function 187 (Login Manager). 
Alternatively, if the Login can edit preferences manager-controlled option is enabled for the login, Preferences can be set from menu 
option Edit » Preferences.  
 
To open the Login Manager, choose Admin » Login Manager from within any Millennium module.  
 

 
 
 
Select the login you want to customize, and press Preferences button.  
 

 
 
 
The Preferences are divided into five tabs: Colors and Fonts, View, Editor, Editor font and Editor Colors:  
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INTRODUCTION TO PREFERENCES | Login Manager

 
 
 
Preferences work the same in all modules, and can be modified from the Login Manager for any login irrespective of what module you 
are logged in to. The only exception is in the Colors section, where the elements vary slightly between the modules.  
 
NOTE: When you save Settings permanently, the changes will apply to ALL logins that do not have customized Preferences. Therefore 
it is recommended that you define a customized set of Preferences for all logins before you start making permanent changes to 
Settings.  
 
When a module is accessed from Millennium control bar, the original login's Preferences are used.  
 
Refer to section Working with the Login Manager for instructions on how to edit or copy Preferences.  
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COLORS AND FONTS | Login Manager

COLORS AND FONTS

The Colors and Fonts tab looks similar to the following. The example is from Millennium Acquisitions:  
 

 
 
 
Note that the elements in the Colors section vary slightly between the modules.  
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LOOK & FEEL | Login Manager

LOOK & FEEL

 
 
 
The look and feel setting controls the general appearance of components (e.g., buttons, drop-down lists, check boxes) in a Java® 
application. There are two types of "look and feel":  
 
Metal - the standard Java® look and feel 
 

Windows - corresponds to the appearance of Microsoft's Windows
TM

 operating system 
 
Example of the Metal look and feel, Green theme: 
 

 
 
 
Example of the Windows look and feel:  
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THEMES | Login Manager

THEMES

 
 
Innovative has defined Themes, or collections of colors and fonts, which can be used with the Metal look and feel discussed in the 
previous step. If you select a theme, the theme's colors and fonts override any color and font choices you have made previously. The 
available themes are:  
 
III Theme  
 

 
 
 
Green Theme  
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Blue Theme  
 

 
 
 
To use a particular theme, select the theme from the drop-down list and choose Set. You need to restart the Millennium session to see 
the full effects of a theme change.  
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COLORS

 
 
 
If you are using the Metal look and feel, you can define your own color scheme using the elements listed below. If you are using the 

Windows look and feel, the color scheme corresponds to the appearance of Microsoft's Windows
TM

 operating system.  
 
You can set colors for:

●     Text - defines the color of text in windows and dialogs. 

●     Entry highlight - defines the color of the currently selected entry in a browse display. 

●     Button highlight - defines the color of a selected button. 

●     Selection highlight - defines the color of the currently selected tab and the vertical scroll bar. 

●     Button borders - defines the border color for buttons. 

●     Background - defines the background color for the entire application. 
●     Tab Alert - defines the alert color for patron record tabs, e.g. used to indicate that there is a hold awaiting pickup or an 

outstanding fine.  

●     Arrived box - defines the color for a checkin card box with status "Arrived".   

●     To Bind/Bound box - defines the color for a checkin card box with status "To Bindery" or "Bound".  

●     Late box - defines the color for a checkin card box with status "Late".  
●     Completed box - defines the color for a completed entry (i.e. an entry that includes location, fund and copies) in the Selection 

List display. 
●     Incomplete box - defines the color for an incomplete entry (i.e. an entry that does not include location, fund or copies) in the 

Selection List display. 
●     Out of Scope box - defines the color for a Selection List display entry in which the locations and funds are out of scope (i.e. 

non-editable) for the user. 

To set a color, click on a colored square to open the Choose a color dialog. You can set the desired color using the Swatches, HSB, or 
RGB tab. Note that you only need to set the color in one of the tabs; choose whichever tab you prefer.  
 
TO SET THE COLOR USING THE SWATCHES TAB:  
 

1.  Click on a color square from the palette. The system adds your color to the Recent list of colors and shows you a preview of 
the color in the bottom portion of the dialog:  
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The Recentlist of colors contains a history of the colors you have selected while the Choose a colordialog is open. Once you 
close the Choose a colordialog, the list is erased.  
 

2.  Choose OK to set the color. You can also choose Reset to view your original color or Cancel to exit. 

 
 
TO SET THE COLOR USING THE HSB (hue-saturation-brightness scheme) TAB: 

1.  Choose a color in one of three ways: 
�❍     Select a hue by dragging the slider up or down the color bar; in the example below, the slider points to blue. Then 

choose an exact color by moving the "selection circle" within the color picker.
�❍     Select the H radio button and then move the slider up or down the color bar to choose a hue. Next, select the S radio 

button and then move the slider up or down the color bar to choose a saturation value. Finally, select the B radio 
button and then move the slider up or down the color bar to choose a brightness value. 

�❍     Enter numeric values for hue, saturation, and brightness in the H, S, and B text boxes. 
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Note that as you choose a color, the system adjusts the RGB values and displays a preview of the color in the bottom portion of 
the dialog.  
 

2.  Choose OK to set the color. You can also choose Reset to view your original color or Cancel to exit the dialog without 
changing the color.

TO SET THE COLOR USING THE RGB (red-green-blue scheme) TAB:

1.  Choose a color in one of two ways: 
�❍     Drag the sliders for Red, Green, and Blue to set the value for each, or 
�❍     Enter numeric values in the Red, Green, and Blue text boxes. 

 
 

file:///C|/PROJECTS/TUTORIAL%20LoginManager%202008%20-%20UPDATES/print_preferences2_3.html (3 of 4) [10/27/2008 11:05:44 AM]



COLORS | Login Manager

 
 
 
Note that the system displays a preview of the color in the bottom portion of the dialog.  
 

2.  Choose OK to set the color. You can also choose Reset to view your original color or Cancel to exit the dialog without 
changing the color. 
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FONT SETTINGS 

 
 
 
If you are using the Metal look and feel, you can define the font used to display text. You can set the font type, size, and style (i.e. 

bold and/or italic). Note that the Windows look and feel uses the font parameters from your Windows
TM

 setup.  
 

To run Millennium applications, your monitor must have a minimum resolution of 800 x 600. With this setting, you 
should not set a font size larger than 16 point bold. Note that higher resolution monitors can accommodate larger 
font sizes. 
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DEFAULT CODE CHART

 
 
 
This setting determines which default code chart to use in the Character Map function in the editor. Note that the code chart can also 
be changed interactively by the user via the Tools » Character Map option.  
 
Refer to the Innovative Guide and Reference, Page # 105473: Character Map for information about inserting UNICODE characters into 
records via the code charts.  
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EDITOR

The Editor tab offers the following settings for the record editor: 
 

 
 
 
Using the options on the Editor tab you can customize the appearance and behavior of the Millennium editor. The following settings are 
available: 

●     Display of MARC tags and field group tags or labels
●     MARC validation for bibliographic, authority and checkin records
●     Insert or overwrite mode for MARC tags and indicators
●     Automatic update of field group tag when MARC tag changes

In addition to making permanent changes to the Editor Preferences for a login (as discussed in the Introduction), a user can also make 
temporary changes which only apply to the current session. This method requires no authorization and will only affect the workstation 
where the change was made.  
 
To access the Editor Preferences this way, right click from within a record in edit mode and select Preferences from the menu.  
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SHOW FIELD GROUP AND MARC TAGS

 
 
 
The following options are available: 
 
Show field group 
Choose whether to have the editor display field group tags (e.g. "a" for author fields) or field group labels (e.g. "AUTHOR"). This 
applies to non-MARC fields and, if the box Show field group information for MARC fields is checked, for MARC fields as well.  
 
Show MARC tags/indicators 
Check this option to make the editor display MARC tags and indicators when editing MARC records.  
 
Show field group information for MARC fields 
Check this option to make the editor display field group information for MARC fields.  
 
TAGS & LABELS  
 
You can vary the display of MARC and non-MARC variable length fields: FLASH version

MARC tags and indicators in variable length fields, with or without field group 
labels

 

non-MARC fields by tag or label  
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SHOW MARC VALIDATION

 
 
 
Check this option to perform validation on all MARC fields when a bibliographic, authority, or holdings/checkin record is being created 
or edited. The box is checked by default. When the box is un-checked, validation is turned off for all open MARC records. When the box 
is checked again, validation is turned on for all open MARC records and all subsequent MARC records are validated when opened.  
 
Refer to the Innovative Guide and Reference, Page # 105692: Validating MARC Tag Information for information about validating MARC 
tag information in the Millennium Editor.  
 
OVERWRITE MARC TAGS/INDICATORS  
 

 
 
 
Check this option to choose to overwrite, rather than insert, existing MARC tags and indicators when editing a MARC record. When this 
box is checked, placing the cursor in the MARC tag, Indicator 1 or Indicator 2 positions in a record causes the editor to be in 
OVERWRITE mode. When the cursor moves to the main data portion of a MARC field, the editor switches to INSERT mode.  
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UPDATE FIELD GROUP TAG WHEN MARC TAGGING CHANGES

 
 
 
If this option is selected, the field group tag will automatically be corrected when you exit a MARC field whose MARC tag and/or 
indicators have been updated.  
 
Example: change MARC tag 110 (field group tag 'a') to 710 (field group tag 'b'). 
Before the change: 
 

  

 
After the change - the field group tag is updated as soon as you exit the field (record not saved at this stage): 
 

  

 
The editor uses the appropriate m2btab.fse.* load table to find the association between field group tags and MARC tags/indicators for 
bibliographic, item and holdings/checkin records (the asterisk represents a possible extension, such as m2btab.fse.uni for UNIMARC 
bibliographic records, or m2btab.fse.i for item records). Some systems do not have a m2btab.fse.* table, in which case m2btab.b.* will 
be used instead.  
 
The load table used for authority records is primarily m2btab.anam.* or m2btab.asub.*, depending on authority type (the asterisk 
represents a possible extension, such as m2btab.anam.chi for Chinese MARC). On some systems, m2btab.a.* is used instead.  
 
Load tables can be viewed via character based system menus: 
M > MANAGEMENT information 
  I > INFORMATION about the system 
    C > CODES used 
      M > MARC load tables 
       [select appropriate table depending on record type and MARC type]  
 
If the MARC tag is not defined in the load table, and no field group can be found, a question mark - '?' - is placed as the field group 
tag, and when you save the record you will be asked to select a tag:  
 

 
 
 
The update of field group tags will happen whether or not you choose to show the field group information  
 

Contact Innovative to add missing MARC tags to existing load tables. 
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EDIT COLORS

The Editor Colors tab contains the following options: 
 

 
 
 
When you first enter the Editor Colors tab, Use default colors will be selected. To specify a different combination of foreground and 
background colors, uncheck the default option. For each type of text element you will see in the editor, e.g., Default text, MARC tag, 
etc., select the corresponding Foreground color square. Then choose a color from either the Swatches, the HSB, or the RGB tab. Then 
select the corresponding Background color square and choose the desired color.  
 
You can specify colors for different elements of a record: FLASH version

Default text

Fixed length field labels

Field group information (tags or labels) for variable length fields

MARC tags
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MARC indicator

Subfield tag

URL links

System-generated fields

Z39.50: Field will not be loaded

Invalid text (such as incorrect field group tags, blank fixed fields)

Non-editable text (in fixed fields)  
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EDITOR FONT

The Editor Font tab contains the following options: 
 

 
 
 
When you first enter this tab, Use default font will be selected. The default font used depends on what Look and Feel and Theme 
settings you have selected for the login. To specify a different combination of font face, size, and style for all text displayed in the 
record editor, uncheck the default option. Then, select the desired Name and Size from the drop-down lists and check Bold and/or 
Italic if desired.  
 
Change the font size and type for the record editor as shown below: FLASH version

Default text  
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VIEW

The View tab contains the following options: 
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SHOW TABLE TOOLTIPS ON STARTUP | Login Manager

SHOW TABLE TOOLTIPS ON STARTUP

 
 
 
This setting determines whether tooltips are displayed by default for the login. Tooltips are displayed when you move the mouse over a 
button or icon.  
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SHOW NAVIGATION BAR ON STARTUP

 
 
 
This option determines whether the navigation bar (the vertical strip of modes that displays along the left side of the main window) 
displays. You can also choose whether to display the navigation bar as Text only, Image only or Image and Text.  
 

 
 
 
When the Show Navigation bar on startup setting is unchecked, the navigation bar will not display at startup. The user can then 
access the other modes from the Go menu.  
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SHOW CURRENT MODE ON STARTUP

 
 
 
This setting determines whether the current mode displays in the top left corner of the screen.  
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INTRODUCTION TO SETTINGS

Settings control the behavior of various functions in the Millennium applications, such as the templates, record displays and statistics.  
 
To open the Settings window, choose menu Admin » Settings from within any Millennium application: 
 

 
 
 
A screen similar to the following will appear. (This example is from Millennium Acquisitions): 
 

file:///C|/PROJECTS/TUTORIAL%20LoginManager%202008%20-%20UPDATES/print_settings1.html (1 of 3) [10/27/2008 11:05:47 AM]



INTRODUCTION TO SETTINGS | Login Manager

 
 
 
Related options are grouped on tabs. Tabs vary between each module, as shown in this table: 
 

TABS MODULE

 ACQ ADM CAT CIRC ERM ILL SER

Claiming X

Create Lists X X X X X X X

Export Records X

Funds X

Global Update X X

Import Invoice X

Invoice X

Macros X X X X X X X

Multiselection Groups X

New Records X X X X X X

On-the-fly Records X X

Print Templates X X X X X X X

Rapid Update X

Receive X

Recommendations X

Record Display X X X X X X

Reports X

Search X X X X X X

Session Statistics X

Statistics X X X X X X X

Templates X X X X X X X

Web Options X

Windows X X X X X X 

 
 
You can only change Settings for the login you are currently using (with the exception of logins with undefined Preferences, see the 
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Note below). Settings can be modified at any time during a session and the changes will take effect immediately. Settings can be 
changed for the current session only or permanently as the default for the login. A change for the current session will only affect the 
workstation where the change was made. Changing the Settings permanently will affect other users of the same login, but not until 
they start a new session.  
 
In some cases, changing a setting requires authorization for the function controlled by the setting. For example, to be able to modify 
the Invoice Settings, the user needs to be authorized for function 78 (Process Invoices). The specific authorization number required to 
change a setting is listed in the corresponding tutorial section.  
 
To change your settings for the current session only:

1.  Choose Admin » Settings to open the Settings window. 
2.  Choose the tab that contains the setting option. 
3.  Choose a new value for the setting option. 
4.  Choose OK. 

To save changed Settings permanently (i.e. for the current and subsequent sessions), you must additionally be authorized for function 
176 (Save Settings - Millennium). The Save Settings button is greyed out for unauthorized users.  
 
To change the default settings permanently for the login:

1.  Choose Admin » Settings to open the Settings window. 
2.  Choose the tab that contains the setting option. 
3.  Choose a new value for the setting option. 
4.  Choose Save Settings. 
5.  Choose OK.

 
 
NOTE: When you save Settings permanently for a login, the change applies to any login that does not have a set of customized 
Preferences. Therefore it is recommended to customize the Preferences for the logins before you start saving Settings permanently.  
 
When a module is accessed from the Millennium control bar, the original login's Settings are used. However, the following settings can 
have a unique default value in each Millennium application, even though the applications are launched from a single login through the 
Millennium control bar: 

●     Macros 
●     New Records 
●     On-the-fly Records 
●     Preferred Templates (Record Templates) 

 
 

close window

file:///C|/PROJECTS/TUTORIAL%20LoginManager%202008%20-%20UPDATES/print_settings1.html (3 of 3) [10/27/2008 11:05:47 AM]

file:///C|/PROJECTS/TUTORIAL%20LoginManager%202008%20-%20UPDATES/preferences1.html
file:///C|/PROJECTS/TUTORIAL%20LoginManager%202008%20-%20UPDATES/settings9.html
file:///C|/PROJECTS/TUTORIAL%20LoginManager%202008%20-%20UPDATES/settings11.html
file:///C|/PROJECTS/TUTORIAL%20LoginManager%202008%20-%20UPDATES/settings12.html
file:///C|/PROJECTS/TUTORIAL%20LoginManager%202008%20-%20UPDATES/settings20_1.html
javascript:window.close()


CLAIMING | Login Manager

CLAIMING

The Claiming tab contains options for claiming in Millennium Serials. The following setting is available: 
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COPY CLAIM NOTE TO NEXT CLAIM

 
 
 
To specify that the most recently entered claim note automatically appear in the Note text box of the Claim dialog in Millennium 
Serials, select the check box. If selected, the most recent note will be used by default during the whole claiming session. To specify 
that the Note text box should be blank by default for each claim, clear the check box.  
 
For additional information, refer to the Innovative Guide and Reference, Page # 100454: Claiming Late Issues  
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CREATE LISTS

The Create Lists tab contains options that affect searching in Create Lists mode. The following options are available: 
 

 
 
 
 
 

Create Lists mode has a shortcut to Settings on the toolbar:  
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OPTIONS FOR CREATE LISTS SEARCHING | Login Manager

OPTIONS FOR CREATE LISTS SEARCHING

 
 
 
Don't wait for searches to complete (default) 
This method requires an additional user license, i.e. while the Create Lists search is running your session uses two user licenses. You 
can do other work in the application while the search is running, without waiting for the search to complete. If you start yet another 
search in Create Lists, a third license will be required, etc. 

Should there be no available license in your Login Group you will get an error message when you try to launch the search: "Sorry, 
currently there are no user licenses available to launch a search process. Would you like to save the search criteria?". If you answer 
"Yes" you can save the search criteria and try to start the search at a later time. If you answer "No" the search criteria are discarded.  
 
Wait for searches to complete 
A progress bar displays and you cannot do other work in the application while the search is running. This method requires no additional 
user license.  
 
Prompt to wait for searches to complete 
The system will attempt to use an additional license, so that you can do other work in the application while the search is running. If 
there are no additional user licenses in your Login Group available for the search, you are prompted to run the search as Wait for 
searches to complete.  
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LOOK UP CALL NUMBERS

 
 
 
This option allows you to expand the call number search when you search for the call number in item or holdings/checkin records. If an 
item/holdings record has a call number, that call number is used in the search. If the item/holdings record has no call number, the 
search is expanded to look for a call number in the bibliographic record. If neither the item/holdings record nor the bibliographic record 
has a call number, the item or holdings/checkin record is not included in the results. When you enable this option, you can also use the 
call number field as above when you perform subsequent actions, such as Sort and List, on the review file.  
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INCLUDE COVERAGE DATABASE INFORMATION | Login Manager

INCLUDE COVERAGE DATABASE INFORMATION

 
 
 
If your library has acquired Electronic Resource Management, you can use the coverage database field information when creating 
review files. This option enables the ability to include field data from the coverage database in your criteria when using Create Lists.  
 
For additional information, refer to the Innovative Guide and Reference, Page # 105981: Maintaining Coverage Data for Resources  
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INCLUDE EQUIVALENT 880s | Login Manager

INCLUDE EQUIVALENT 880s

 
 
 
If your library uses 880 fields to store romanized and vernacular characters in your database, select this option to include both main 
fields and equivalent 880 fields in searches.  
 
When you enable this option, it also applies when you perform subsequent actions, such as sort, list and export, on the review file.  
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EXPORT RECORDS

The Export Records tab contains default settings for exporting individual bibliographic or authority records from Millennium 
Cataloging. Note that these parameters can also be set interactively by the user during the export. The following options are available: 
 

 
 
 
NOTE: The record export function is available from all Millennium modules.  
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EXPORT RECORD OPTIONS | Login Manager

EXPORT RECORD OPTIONS

 
 
 
File name 
Enter a file name, including the directory and path, to specify an output file for exporting. Alternatively, you can specify a file by 
choosing Browse and selecting an existing file.  
 
Output table 
Choose the output load table that defines the mapping of Innovative fixed-length and variable-length fields to MARC fields and 
subfields when the MARC record is exported.  
 
For additional information, refer to the Innovative Guide and Reference, Page # 106001: Exporting an Individual MARC record.  
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FUNDS | Login Manager

FUNDS

NOTE: To view/change this tab the user needs to be authorized for function 085 (Fund file maintenance).  
 
The Funds tab contains options for Fund adjustment and for Fiscal Closing in Millennium Acquisitions. The following options are 
available: 
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OPTIONS FOR FUND ADJUSTMENT | Login Manager

OPTIONS FOR FUND ADJUSTMENT

 
 
 
Display Form Tool in Fund Adjustment  
Select this option to enable the Form Tool when you edit a fund table. If this option is selected, the form tool appears at the top of the 
table on the Adjustment tab in Funds mode.  
 

 
 
 
For information on how to use the Form Tool, refer to the Innovative Guide and Reference, Page # 105489: Using the Form Tool for 
Editing  
 
If Display Form Tool in Fund Adjustment is unchecked, you have to click directly on the Appropriation, Expenditure or 
Encumbrance fields in the fund table to make your adjustments: 
 

 
 
 
To add a note, right click and select Add Note after making the adjustment:  
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OPTIONS FOR FISCAL CLOSE | Login Manager

OPTIONS FOR FISCAL CLOSE

 
 
 
These options allow the user to create various types of statistical reports as an integrated part of the Fiscal Close procedure. Note that 
in creating these reports during Fiscal Close, you do not need to switch modes.  
 
Do Statistics in Fiscal Close 
Select this check box if you want to run a statistical report as part of the fiscal close procedure.  
 
Example of a statistical report on order records: 
 

 
 
 
Do Management Report in Fiscal Close 
Select this check box to be able to run a management report during the fiscal close procedure.  
 
Example 1: Management report on a single fund: 
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Example 2: Management report on a group of funds: 
 

 
 
 
Do Vendor Statistics in Fiscal Close 
Select this check box to be able to run a vendor statistics report during the fiscal close procedure.  
 
Example of a vendor statistics report: 
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For additional information, refer to the Innovative Guide and Reference, Page # 106027: Creating Statistical Reports in Fiscal Close  
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OPTIONS FOR FUND ACTIVITY REPORT | Login Manager

OPTIONS FOR FUND ACTIVITY REPORT

 
 
 
This option allows the user to control the number of funds to display on each page of the Fund Activity Report. For libraries with a large 
number of funds, this setting can be used as a way to reduce the response time when running the Fund Activity Report. For additional 
information, refer to the Innovative Guide and Reference, Page # 105490: Generating the Fund Activity Report.  
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GLOBAL UPDATE | Login Manager

GLOBAL UPDATE

The Global Update tab contains the following options for the Global Update mode in Millennium Cataloging and ERM: 
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OPTIONS FOR GLOBAL UPDATE | Login Manager

OPTIONS FOR GLOBAL UPDATE

 
 
 
Choose a MARC Type 
Specifies the type of bibliographic records that can be updated in Global Update mode. Choose the MARC type that applies to your 
system or (ANY).  
 
Max Search Results (0 for No Limit) 
Specifies the maximum number of records that will be retrieved in a search within the Global Update mode. The default value is 0, 
which indicates that no limit is imposed.  
 

Note that this setting controls what is returned in the search, not what is updated. Setting this to 0=No limit still 
allows you to select a subset of records for processing in Global Update. 

 
 
Create Review File of Busy Records 
When performing updates in Global Update mode, records that are busied by other processes will not be updated. The system will 
report the number of busy records after processing the updates: 
 

 
 
 
Select this option to create a review file of the busy records. Use the Copy function in Create Lists mode to find the review file. It 
appears among other system generated files at the end of the list.  
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IMPORT INVOICE

The Import Invoice tab contains options for processing invoices electronically in Millennium Acquisitions Import Invoices mode.  
 

 
 
 
NOTE: Electronic invoice processing requires the Extended approval plan interface (Product Code 409) and/or Electronic serials 
invoicing (Product Code 410).  
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OPTIONS FOR IMPORT INVOICE | Login Manager

OPTIONS FOR IMPORT INVOICE

 
 
 
Use today's date as receive date 
Select this option to use the date that the invoice is processed as the receive date in the order record.  
 
Use today's date as both receive date and order date 
Select this option to use the date that the invoice is processed as the order date as well as the receive date.  
 
Neither 
Do not update the Receive or Order date fields when processing invoices electronically.  
 
For additional information, refer to the Innovative Guide and Reference, Page # 106113: Loading Records in a Shipment  
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ACCEPT/REJECT DEFAULT TAB OPTION | Login Manager

ACCEPT/REJECT DEFAULT TAB OPTION

 

 
 
 
Process tab is the default tab in Accept/Reject 
Select this option if you want to set the Process tab as the default display when you select an invoice in the Accept/Reject tab.  
 

 
 
 
Extended View tab is the default tab in AcceptReject 
Select this option if you want to set the Extended View tab as the default display when you select an invoice in the Accept/Reject tab.  
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For additional information, refer to the Innovative Guide and Reference, Page # 106021: Accepting and Rejecting Records in a Shipment, 
and Page # 106425: Using the Extended View in the Accept/Reject Tab.  
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INVOICE | Login Manager

INVOICE

NOTE: To view/change this tab the user needs to be authorized for function 78 (Process invoices).  
 
The Invoice tab contains options for creating new invoices in Millennium Acquisitions Invoice mode.  
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OPTIONS FOR NEW INVOICE | Login Manager

OPTIONS FOR NEW INVOICE

 
 
 
Don't ask these questions 
If this check box is not selected, a dialog containing the Invoice options listed below will display the first time you enter Invoice mode 
during a session. Select this check box to choose default Invoice options and prevent the dialog from displaying automatically.  
 
Use Paid Date as Date Received? 
This option is offered if your Acquisition Option Combine receiving and invoice entry is set to "Yes." 
If this check box is not selected, the system does not change the order record's RDATE (e.g. when receiving and invoice processing are 
done at different times, for partial receipts, or when processing invoices for prepaid orders).  
 
Warn if the item has not been received? 
This option is only offered if you uncheck the Use Paid Date as Date Received? setting above. 
If this check box is selected, the system warns you when you process an invoice for a record that has not been received. If this check 
box is not selected, the warning is suppressed (e.g. when processing an invoice for a pre-paid order).  
 
Prompt for note for each line item? 
If this check box is selected, the system prompts you to add a note as you key the line item. If this check box is not selected, you can 
add a note to the line item, but are not automatically prompted to do so.  
 
Are you going to be keying list prices? 
This option is offered if your Acquisition Option Key both list price and net price on invoice is set to "Yes." 
If this check box is selected, the system allows you to key a list price and a net price (in the Paid column) for each order record. If this 
check box is not selected, the system allows you to key a net price for each order record.  
 
Display subscription dates on invoice?  
If this check box is selected, the system automatically displays the Sub From and Sub To columns during invoicing for entering 
subscription dates. Note that if this option is not selected, the Prompt for subscription dates option below is not available.  
 
Prompt for subscription dates?  
This option is offered if you select the option Display subscription dates on invoice above. If this check box is selected, the system 
uses a popup box to remind users to enter subscription dates during the invoicing process.  
 
Use foreign currency amounts? 
This option is offered if your Acquisition Option Library uses foreign currencies is set to "Yes". 
If this check box is selected, the system allows you to toggle between foreign and local currency using the Tools menu. When you 
start the invoice processing, you are prompted to choose a foreign currency. The currencies and rates displayed are from your Foreign 
Currency Table. If this check box is not selected, currency will be keyed in local currency and cannot be converted to foreign currency.  
 
Apply usetax 
This option is offered if your Acquisition Option Library subject to use tax is set to "Yes" or "Yes (specify rate)". The value entered 
here will be the default when processing invoices.  
 

You can change the default use tax setting on the actual invoice form by choosing an alternate option in the Apply 
usetax pull-down menu. 
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The following options are available: 
 
None - no use tax is charged for the invoice 
 
All - the use tax rate is applied to all line items on the invoice 
 
Some - for each line item on the invoice, check the Usetax check box to indicate that use tax should be charged for that item 
 

 
 
 
As Coded - the system checks for a coded field in the order record. If the field is coded with the value for use tax, the line item is 
charged for use tax. Contact Innovative to set up order record encoding.  
 
For additional information, refer to the Innovative Guide and Reference, Page # 100642: Entering Invoices with Use Tax  
 
Rate 
This option is offered if your Acquisition Option Library subject to use tax is set to "Yes (specify rate)", and Apply usetax is set to 
"All," "Some," or "As Coded".  
 

 
 
 

You cannot use more than one usetax rate on a single invoice. 

 
 
Use tax rates are entered by the library. For further information, refer to the Innovative Guide and Reference, Page # 105535: 
Maintaining Use Tax Rates 
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MACROS | Login Manager

OPTIONS FOR NEW INVOICE

The Macros tab allows you to customize the keyboard function keys. The system offers the ability to customize function keys F1 
through F12, and also these function keys in combination with Alt, Ctrl, and Shift, e.g. Alt+F1, Ctrl+F1, Shift+F1, etc.  
 

 
 
 
You can create macros for frequently used text strings, diacritic characters that are not available on your keyboard, as well as for 
keyboard shortcuts to various functions in the Millennium modules. 
Note that the system designates a particular function key as "RESERVED" if it is unavailable for customization.  
 
If you have customized your function keys by using macros, you press the function key or function key combination to activate the 
macro.  
 
The sample screen above represents the default setup for Millennium Acquisitions. In this example, function key F1 has a value 
meaning "Change the current mode to Orders". The macro uses the keyboard commands offered by underlined characters:%ALT+g%o 

 Alt-G to open the Go menu, then 'o' to get to Orders mode.  
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Using F1 will take you to Orders mode from wherever you are in Millennium Acquisitions.  
 
If desired, you can change the defaults and edit the function keys to perform other actions.  
 
For a complete list of predefined values in all modules, refer to the Innovative Guide and Reference, Page # 100743: Function Keys  
 
For detailed information about customizing function keys, refer to the Innovative Guide and Reference, Page # 105847: Macros 
Settings  
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MULTISELECTION GROUPS | Login Manager

MULTISELECTION GROUPS

The Multiselection Groups feature allows you to associate combinations of location codes, fund codes, and number of copies with a 
login. A screen similar to the following appears: 
 

 
 
 
During order record creation, you can use Multiselection Groups as a quick method to order copies for multiple locations.  
 
The first step is to create Multiselection Groups in Millennium Acquisitions as part of the Acquisitions parameters.  
The Multiselection Groups are created in Admin| Parameters| Acquisitions| Multiselection Groups  
 
For additional information about creating Multiselection Groups, refer to the Innovative Guide and Reference, Page # 105932: 
Maintaining Multiselection Groups  
 
You can then use the Multiselection Groups tab in Settings to specify which groups display for each login. Users can access 
Multiselection Groups available to them when creating/editing order records in both the Orders and Selection Lists modes.  
 
Add to or remove from your list of Preferred Groups by doing the following:  
 

Add to your list Select the group in the Other Groups list and click the left arrow.

Remove from your list Select the group in the Preferred Groups list and click the right arrow. 

 
 

�❍     To move multiple groups at the same time, select the groups by holding down the Ctrl key and clicking on the names. 
Then choose the appropriate arrow button.

�❍     When you click on a Multiselection Group, you will see the combination of locations, funds, and numbers of copies 
associated with that group in the Preview Multiselection Group table.
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MULTISELECTION GROUPS | Login Manager

From the Default Group drop-down menu, select how the Preferred Groups will be offered when you use the Multiselection Group 
feature to add copies: 

●     Always prompt: You will always be prompted by a dialog to select a Multiselection Group from the Preferred Group list 
when you add copies to an order.

●     Prompt to select: You will be prompted by a dialog to select a Multiselection Group from the Preferred Group list the first 
time that you add copies to an order. Afterwards, the Multiselection Group you chose will automatically be used as the default 
group for the remainder of the session. When starting a new session, you will be prompted again to choose a default group. 

●     [ name of group ]: Choose a Multiselection Group from the drop-down menu. The Multiselection Group you choose will be the 
default selection, and you will not be prompted by a dialog to select a group when you add copies to an order. 

When you edit location, fund, and copy information, Millennium displays the Edit Data dialog. By choosing the Add Group button, 
Millennium will either automatically populate the table with the combinations of locations, funds, and number of copies defined for that 
Multiselection Group; or, depending upon the settings for your login, prompt you to choose a Multiselection Group.  
 
Edit Data dialog: 

 
 
 
Example 1: If Default Group is set to Prompt to select or Always prompt, you will be prompted to choose from the groups in the 
Preferred Groups list: 
 

 
 
 
Example 2: If Default Group has a Multiselection Group predefined, the system automatically populates the Location, Fund and # 
Copies fields with the appropriate values: 
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NEW RECORDS | Login Manager

NEW RECORDS

The New Records tab provides the following options for creating new records in Millennium: 
 
NOTE: To view/change this tab the user needs to be authorized for function 073 (Key New Records - ACQ).    
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OPTIONS FOR ORDER VIEW | Login Manager

OPTIONS FOR ORDER VIEW

 
 
 
Show Selection List 
Select this check box to specify whether the Selection List tab will display for order records in Orders Mode.  
 

 
 
 
For additional information, refer to the Innovative Guide and Reference, Page # 100800: Using Selection Lists  
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OPTIONS FOR NEW ITEM RECORDS

 
 
 
Prompt for Multiple Items 
Select this check box to specify that a prompt for multiple items will display during creation of new item records.  
 
If this option is selected the New Item Options dialog box will appear when you start creating items, e.g by clicking on Attach New 
Item on the item summary: 
 

 
 
 

 
 
 
For further information about creating multiple item records, refer to the Innovative Guide and Reference, Page # 104019: Creating 
Item Records in Millennium Cataloging  
 
If this check box is not selected, a single item will be created by default.  
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OPTIONS FOR NEW HOLDINGS RECORDS

 
 
 
Create checkin card when creating holdings record 
Select this check box to specify that a checkin card should be created when a new holdings/checkin record is created. 
If this check box is not selected, the system will not automatically prompt the user to create the card. The user can then create the 
checkin card on demand by using the Create Card button on the Card tab.  
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OPTIONS FOR NEW ORDER RECORDS

 
 
 
Don't ask these questions when creating new order records 
If this check box is not selected, a dialog box containing the options listed below will display the first time you attach a new order 
record in Orders, Invoice or Rapid Receive mode during a session. Select this check box to choose default options and prevent the 
dialog from displaying automatically.  
 
Use Today's Date as Order Date? 
If this check box is selected, today's date will be used as the order date. If the check box is not selected, you are expected to enter the 
order date manually in the ODATE (Order date) field when keying the order record.  
 
Use Today's Date as Received Date? 
If this check box is selected, today's date will be input as the received date in the order record's RDATE (Received date) field when 
keying new order records.  
 

This option is useful if you want to create order records retroactively for items already received. 

 
 
If this check box is not selected, the RDATE field will remain blank when keying new order records.  
 
Queue Purchase Orders for records? 
If this check box is selected, purchase orders will be queued for printing or electronic transmission when new order records are 
created. Regardless of this setting, the user can check/uncheck the "Queue P.O" setting on demand when creating order records.  
 

 
 
 
When the Queue Purchase Orders for records setting is selected, the Queue P.O. option will be checked by default when keying 
order records and purchase orders will be queued for printing or electronic transmission unless you uncheck the box.  
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NEW RECORD TEMPLATES | Login Manager

NEW RECORD TEMPLATES

 
 
 
You can specify default templates for creating the following record types:

●     authority 
●     bibliographic 
●     checkin 
●     contact
●     course 
●     item 
●     license 
●     order 
●     patron 
●     program
●     resource 
●     section
●     vendor

To choose a template at the time of record creation, set the template option as Always prompt for template or Prompt for 
Template.  
 

When you select Prompt for Template, the system will prompt you for a template the first time you create a record 
during the session. For subsequent records, the system will remember the most recent template used during record 
creation. If you want to be prompted each time a new record is created, select the Always prompt for template 
option. 

 
 
If you have selected a list of Preferred Templates, only those templates will display in the list for each record type.  
 
For information about adding new templates to the system, refer to the Innovative Guide and Reference, Page # 105825: Managing 
Templates for New Records  
 

close window

file:///C|/PROJECTS/TUTORIAL%20LoginManager%202008%20-%20UPDATES/print_settings11_5.html [10/27/2008 11:05:55 AM]

file:///C|/PROJECTS/TUTORIAL%20LoginManager%202008%20-%20UPDATES/settings20_1.html
http://csdirect.iii.com/manual/gmil_maint_templates_manage.html
http://csdirect.iii.com/manual/gmil_maint_templates_manage.html
javascript:window.close()


RECORDS TO ATTACH TO NEW BIBLIOGRAPHIC RECORDS | Login Manager

RECORDS TO ATTACH TO NEW BIBLIOGRAPHIC RECORDS

 
 
 
Choose the record types to be automatically attached to new bibliographic records. This setting allows you to create the bibliographic 
record and its attached record(s) in one step. After finishing keying a new bibliographic record, you will be prompted automatically for 
the record type(s) selected here.  
 

If you do not create the attached record (i.e. you click on "Cancel New Record Creation") when automatically 
prompted, your bibliographic record will not be saved. If you regularly create groups of bibliographic records without 
attached records, you should uncheck the box for item, order, and checkin, as desired. 
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ON-THE-FLY RECORDS

The On-the-fly Records tab contains the following options for On-the-fly records in Millennium Circulation and Interlibrary Loans: 
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NEW RECORD TEMPLATES | Login Manager

NEW RECORD TEMPLATES

 
 
 
You can specify default templates for creating the following record types:

●     bibliographic 
●     item 
●     patron 

If you want to choose a template at the time of record creation, set the template option as Always prompt for template or Prompt 
for template.  
 

When you select Prompt for template, the system will prompt you for a template the first time you create a record 
during the session. For subsequent records, the system will remember the most recent template used during record 
creation. If you want to be prompted each time a new record is created, select the Always prompt for template 
option. 

 
 
If you have selected a list of Preferred Templates, only those templates will display in the list for each record type.  
 
NOTE: The settings on this tab override the following Circulation Options: 
Item-on-fly : Defaults for on-the-fly Bib records 
Item-on-fly : Defaults for on-the-fly Item records 
Patron-on-fly : Defaults for on-the-fly Patron records  
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PRINT TEMPLATES

The Print Template feature allows for more flexible and customizable output of specific print jobs. Print Templates also provide 
enhanced support for printing diacritics and an option to save your print job to disk in PDF format. 

With the appropriate editing software (e.g., iReport), you can specify the data that appears on these forms as well as control font 
selection, layout, and incorporation of graphic images into these forms, which can be printed to a printer or exported to disk. 

The Print Template tab contains different output options depending on the module. This example is from Millennium Acquisitions: 

 

Currently, Millennium supports Print Templates for the following output types: 

●     Purchase Orders
●     Monographic Spine Labels
●     Hold Slips
●     ArticleReach Paging Slips
●     Routing Slips
●     Transit Slips

Output Types Vary by Module 

Only the types of templates that are appropriate to the module will display in the Print templates tab when accessed for that login: 

Module Templates that display

Acquisitions
Purchase order 
Routing slip 
Spine label
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Administration All output types

ArticleReach ArticleReach paging slip

Cataloging Routing slip 
Spine label

Circulation

Hold slip 
INN-Reach transit slip - INN-Reach libraries only 
Spine label 
Transit slip

ERM Routing slip

ILL

Hold slip 
INN-Reach transit slip - INN-Reach libraries only 
Spine label 
Transit slip 

Serials Routing slip 
Spine label

Enabling Print Templates 

The first step is to enable Print Templates in D > Database maintenance options in the character-based system: 

40 > Enable Print Templates...................................YES 

After enabling in the system option mentioned above, Print Templates can be implemented on a login by login, output by output basis. 
For example, one user may check the "Use Print Templates" box for output type "Spine labels" only. Print Template administration is 
managed very much like it is for Record Templates. The template concept allows the library to give users printing choices that are 
appropriate for their work. 

For information about printing in Millennium using Print Templates, refer to the Innovative Guide and Reference, Page # 107521: 
Printing With Print Templates 
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PREFERRED/OTHER TEMPLATES

Follow the steps below for maintaining a list of Preferred Print Templates for your login 

1.  Choose the Print Templates tab from Admin | Settings.

 

2.  Choose the Output type (e.g., Purchase Orders, Monographic Labels, etc.) from the Output Type drop-down.
3.  Make certain that the Use Print Templates box is checked.
4.  Add to or remove from your list of Preferred Templates for the selected output type by doing the following: 

Add to your list Select the template in the Other Templates list and click 
the left arrow.

Remove from your list Select the template in the Preferred Templates list and 
click the right arrow.

5.  To move multiple templates at the same time, select the templates by holding down the Ctrl key and clicking the templates' 
names. Then choose the appropriate arrow button. 

6.  When you have finished managing templates, choose OK to save the settings for the current session only. To save your 
preferred templates lists for the current and subsequent sessions, choose Save Settings, then choose OK.

Selecting a Default Template for the Login 

The user's default template is selected from those in the Preferred Templates list with the Select Template drop-down; you can select 
a specific template for the login or one of the following options: 

Prompt for Template 
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The user is asked to choose a template the first time he or she prints. This template is used for the rest of the Millennium session. 

Always Prompt for Template 

The user is asked to choose a template every time he or she prints. 
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TEMPLATE MAINTENANCE

 

To maintain Print Templates, the following authorizations are required: 

●     282|Preview print templates
●     283|Update print templates tab
●     284|Import/export print templates
●     285|Delete print templates

To customize a template, a user would export an existing template from the Millennium server to their PC. This will allow the user to 
start with a template that already has the appropriate data library defined and available for dragging and dropping. Once the template 
has been modified using iReport, the new template may be imported back into Millennium. 

Exporting Print Templates 

To export a template, highlight it in the list and click the Export button. A folder selection pop-up window will open; find and highlight 
the folder where you want to save the template. Click the Choose a directory button to close the pop-up window and export the 
template to the folder path displaying in the "File Name" input box. 

Note that it is not possible to choose a file name for the template files, only a folder. Exported files will have the names with which they 
were imported. 

Editing Print Templates 

Print Templates may be customized for local needs using a third party freeware product called iReport from JasperSoft Corp. (Some 
limited customization is also possible using a text editor such as Notepad). For information about customizing Print Templates using 

file:///C|/PROJECTS/TUTORIAL%20LoginManager%202008%20-%20UPDATES/print_settings_temp3.html (1 of 2) [10/27/2008 11:05:57 AM]

http://www2.jasperforge.org/plugins/mwiki/index.php/Main_Page?group_id=83


TEMPLATE MAINTENANCE | Login Manager

iReports, refer to the Print Templates Wiki. 

Importing Print Templates 

After editing and saving the template in the third party application, click the Import button. In the file selection pop-up window, find 
and highlight the template file to import, as well as any associated graphics files. Click Open. 

You will be prompted for a Name and Description for your templates. "Name" is the short label (max. 10 characters); "Description" can 
be a longer descriptive text (max. 25 characters). When importing a print template, you cannot use a name that is already in use by an 
existing template. In order to reuse a name, you must rename or delete the existing template. 

Previewing Print Templates 

You can view a template by selecting the template from the Preferred Templates or Other Templates list and then clicking Preview. The 
template displays in a separate window. 

NOTE: Be careful to import the image file at the same time if your template uses one (e.g. the library logotype embedded in the 
template). Multiple files can be selected by using the Shift or Control keys while clicking on the file names. Errors like "Failed to create 
preview" or "The document was rendered but could not be printed." will occur if your template contains references to a graphic, but the 
graphic file was not imported with the template file. 

Renaming Print Templates 

You can rename a template by selecting the template from the Preferred Templates or Other Templates list and then clicking Rename. 
You are then prompted to enter a name of up to 10 characters and a description of up to 25 characters for the template. Both name 
and description can contain standard alphanumeric characters only and cannot contain the underscore character. 

Deleting Print Templates 

You can delete a template by selecting the template from the Preferred Templates or Other Templates list and then clicking Delete. 

NOTE: Deleting a Print Template will only remove it from Millennium, not from the folder where it is currently stored on your PC or 
network. 

NOTE ABOUT DEFAULT TEMPLATES: The Print Templates feature comes with a set of default templates. These are identified by a 
leading underscore character in the template's name (e.g., "_7005gyld" in the list shown above). The default templates are intended to 
serve as a solid foundation for further customization by individual libraries. These source templates can be exported but not renamed 
or deleted by the user. For additional information, refer to the Innovative Guide and Reference, Page # 107687: Creating Customized 
Print Templates and the Print Templates Wiki. 
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RAPID UPDATE

NOTE: To view/change this tab the user needs to be authorized for function 76 (Rapid updating).  
 
The Rapid Update tab contains the following options for the Millennium Acquisitions Rapid Update mode: 
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OPTIONS FOR RAPID UPDATE | Login Manager

OPTIONS FOR RAPID UPDATE

 
 
 
Don't ask these questions when receiving 
If this check box is not selected, a dialog containing the Rapid Update options listed below will display the first time you change to the 
Rapid Receive - Rapid Update submode during a session.  
 
Select this check box to choose default Rapid Update options and prevent the dialog from displaying automatically.  
 
Update Single Record 
Select this option to update a single record. You must choose either this option or the Update Multiple Records option.  
 
Update Multiple Records 
Select this option to update multiple records from a review file, range, or index. You must choose either this option or the Update 
Single Record option.  
 
Do you want the order record displayed if one of the following is true 
Select one or more of the check boxes listed below to specify the conditions under which you want the order record to display when 
using Rapid Update, Single Record mode. Millennium will prompt you to display each record that meets the selected criteria before 
updating it.  
 

 
 
 
The record has multiple branches and funds  
 
The record has a special RACTION code.  
 
The records has STATUS other than 'o'  
 
The record already has an RDATE  
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RECEIVE

NOTE: To view/change this tab the user needs to be authorized for function 127 (Receive/add item).  
 
The Receive tab contains the following options for the Millennium Acquisitions Rapid Receive mode: 
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OPTIONS FOR RECEIVE

 
 
 
Choose Select All by default 
If this box is selected, all ordered copies will be selected automatically when accessing the Receive tab in either Orders mode or in 
Receive and Create Items mode. Regardless of this setting, you can select or deselect copies as desired during the receiving 
process.  
 
Example 1: Choose Select all by default is enabled:  
 

 
 
 
Click on Receive if all copies are received at the same time. If not, uncheck Select all and select the copies that should be received.  
 
Example 2: Choose Select all by default is not enabled: 
 
 
 

 
 
 
Only the first copy in the list is selected. Click on Receive to receive that copy, or change selection as desired.  
 
Item Template 
Select an item template from the drop-down list to use when receiving orders via the Receive tab or in Rapid Receive - Receive and 
Create Items submode. You can also choose to Prompt for template. If you have selected a list of Preferred Templates for item 
records, only those templates will display in the list.  
 

If you select Prompt for template, the system will prompt you for a template the first time you create a record 
during the session. For subsequent records, the system will remember the most recent template used during record 
creation. If you want to use a different template for the next record, go to Admin|Settings|Receive and select 
another template or Prompt for Template. 
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RECOMMENDATIONS

NOTE: To view/change this tab the user needs to be authorized for function 190 (Process patron recommendations).  
 
The Recommendations tab contains the following options for the Millennium Acquisitions Recommend mode: 
 

 
 
 
The Recommendations tab is divided into two sections. The top part of the tab refers to settings for new order records created during 
the Approve and Acquire process in Recommend mode. The bottom part of the tab sets the default templates for new records 
created from within Recommend mode.  
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OPTIONS FOR NEW ORDER RECORDS

 
 
 
Don't ask these questions when creating new order records 
If this check box is not selected, a dialog box containing the options listed below will display the first time you create a new order 
record in Recommend mode. Select this check box to choose default options and prevent the dialog box from displaying 
automatically.  
 
Use Today's Date as Order Date? 
If this check box is selected, today's date will be used as the order date. If the check box is not selected, you are expected to enter the 
order date manually in the ODATE (Order date) field when keying the order record in Recommend mode.  
 
Use Today's Date as Received Date? 
If this check box is selected, today's date will be input as the received date in the order record's RDATE (Receive date) field when 
keying new order records in Recommend mode.  
 

This option is useful only when you want to create order records retroactively for items already received. 

 
 
If the check box is not selected, the RDATE field will remain blank when keying new order records in Recommend mode.  
 
Queue Purchase Orders for records? 
If this check box is selected, purchase orders will be queued for printing or electronic transmission when new order records are 
created. Regardless of this setting, the user can check/uncheck the "Queue P.O" setting on demand when creating order records in 
Recommend mode.  
 

 
 
 
When the Queue Purchase Orders for records setting is selected, the "Queue P.O" option will be checked by default when keying 
order records and purchase orders will be queued for printing or electronic transmission unless you uncheck the box.  
 
Add Selector field to new orders? 
When this option is set, the system adds a variable-length field SELECTOR, containing the name of the selector from the patron record, 
to each order record you create in Recommend mode. If your library does not have the Selector Tag set up, this option is unavailable.  
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NEW RECORD TEMPLATES

 
 
 
You can specify default templates for creating the following record types in Recommend mode:

●     bibliographic (applies to the Approve and Acquire function) 
●     order (applies to the Approve and Acquire function) 
●     patron (applies to the Selectors submode) 

If you want to choose a template at the time of record creation, set the template option to Always prompt for template or Prompt 
for template.  
 

When you select Prompt for template, the system will prompt you for a template the first time you create a record 
during the session. For subsequent records, the system will remember the most recent template used during record 
creation. If you want to be prompted each time a new record is created, select the Always prompt for template 
option. 

 
 
If you use this option and have selected a list of Preferred Templates, only those templates will display in the list for each record type.  
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RECORD DISPLAY

The Record Display tab contains options affecting the brief record display of bibliographic records.  
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OPTIONS FOR BIB VIEW

 
 
 
Show Book Jacket 
This option specifies whether the book jacket image appears on record displays.  
 

 
 
 
For information about setting up the Book jacket feature, refer to the Innovative Guide and Reference, Page # 100808: Maintaining the 
Web Links File  
 
If your library has acquired the WebBridge product, resources for book jacket display in staff modules are defined in WebBridge 
management instead. Refer to the Innovative Guide and Reference, Page # 106463: Displaying Book Jackets and Cover Art in 
Millennium  
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SUMMARY VIEW | Login Manager

SUMMARY VIEW

 
 
 
If no records to display, show all others 
Each Millennium application has a default record type that displays in the record summary tab below the brief bibliographic window 
when records are retrieved in a search (or, in the case of Electronic Resource Management, below the resource record). 
This option specifies what is displayed in the record summary when none of the attached records is of the default type (e.g. the default 
type is item records and the bibliographic record has no attached item records):  
 

●     If this option is checked, a summary list of "all records" is displayed. 
●     If this option is not checked, an empty summary list is displayed. 

 
 

The If no records to display, show all others setting can also be accessed interactively by the user and changed 
for the current session by using View » Record View Properties. 

 
 
For example, in Millennium Serials, the checkin/holdings record is the default record type for the summary display. If you retrieve a 
bibliographic record which has an item but no checkin/holdings record attached, the summary display will appear as follows: 
 
a) If no records to display, show all is checked: 
 

 
 
 
b) If no records to display, show all is unchecked: 
 

 
 
 
The default record type for each module is as follows: 
 

Application Mode Default record type

Millennium Acquisitions Orders, Claim/Cancel, Rapid 
Receive, Selection List, Invoice Order

Millennium Administration Has no search mode not applicable

Millennium Cataloging Quick Edit, Delete Items Item
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Millennium Circulation Search/Holds Holds/Bookings (which is a special 
display of item records)

Millennium Electronic Resource 
Management Quick Edit Licence

Millennium Inter-Library Loan Has no search mode not applicable

Millennium Serials Serials Check-in, To Bindery, Check 
In Bound Checkin/Holdings 

 
 

The default record type can be changed for the current session, by using menu View » Record View Properties. 
You can also change the record type view on a record by record basis by using the View drop-down list on the 
Summary tab. Only the options for record types that you are authorized to access will display. 

 
 
Default to checkin card tab for holdings/checkin records 
Specifies that the checkin Card tab automatically displays when a checkin/holdings record is selected from the Summary view. If no 
checkin card currently exists, the Card tab displays the Create Card option.  
 
If this option is not selected, the Record tab displays when a checkin/holdings record is selected from the Summary view.  
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BROWSE OPTIONS

 
 
 
Suppress Authority Records in Advanced Search Browse 
This option specifies whether authority records appear in a browse list when using Advanced keyword searching in Millennium staff 
modules.  
 
NOTE: This setting is only available for libraries that are using the option to include authority records in the Keyword Index.  
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BRIEF DISPLAY

 

 
 
 
Display equivalent 880 fields  
 
If your library uses 880 fields to store romanized and vernacular characters in your database, select this option to include both main 
fields and equivalent 880 fields for any field that is set up to display in the brief record display area for authority and bibliographic 
records. 
The system will follow the subfield |6, if one exists, to the equivalent 880 field and display both fields.  
 
Brief displays are seen above search browses and above the summary of attached records when viewing a single title. The brief display 
is customizable and can vary by module. Contact Innovative to change the displays on your system.  
 
Example of a brief display on a browse screen: 
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REPORTS

The Reports tab includes options for customizing the Headings report in Millennium Cataloging Headings Reports mode.  
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HEADINGS REPORTS

 
 
 
This setting allows you to customize the Headings Reports by adding or removing columns. The following columns are available: 
 
Type of Report - Type of headings report entry, e.g. "Headings used for the first time", "Invalid headings" 
 
Entry - The field data and record number for an entry in the headings report 
 
Cataloging Date - Date the record in the headings report was catalogued (CAT DATE).  
 
Function - System function through which the heading was entered, for example "mcat" for editing MARC records in Millennium 
Cataloging. For additional information, refer to the Innovative Guide and Reference, Page # 105951: Function Codes  
 
Group - If your library has Statistical groups set up for user's login, this column displays the statistics group by which the heading was 
changed. For additional information, refer to the Innovative Guide and Reference, Page # 106047: Statistical Group Table  
 
Initials - User initials of the operator who made the change.  
 
Date of Entry - Date and time the heading was changed.  
 
Add or remove columns from your headings reports by doing the following: 
 

Show Columns Select the column in the list of Hide Columns and click the left arrow.

Hide Columns Select the column in the list of Show Columns and click the right arrow. 

 
 
To move multiple columns at the same time, select the columns by holding down the Ctrl key and clicking the column names. Then 
choose the appropriate arrow button.  
 
Headings report with all columns shown:
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SESSION STATISTICS

The Session Statistics tab contains the following option for displaying Session Statistics in Millennium Cataloging: 
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OPTION FOR VIEWING SESSION STATISTICS | Login Manager

OPTION FOR VIEWING SESSION STATISTICS

 
 
 
View session statistics upon closing 
Select this check box if you want a report of session statistics to display automatically each time you exit Millennium Cataloging.  
 
After you exit, e.g. by using File|Exit, then answering "Yes" to question Exit Millennium Cataloging?, the statistics screen will appear: 
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SEARCH

The Search tab allows you to customize search options.  
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SEARCH DEFAULT

 
 
 
This option allows you to select where the cursor focus is initially in the search panel.  
 
Select index 
If this option is selected, the cursor is initially on the Index drop-down menu when you switch to a search mode: 
 

 
 
 
To change index without using the mouse, use the down arrow to open the drop-down menu and select an index. You can also key the 
index tag, e.g. 'a' for the author index. The index will change and the focus moves to the input box.To move to the input box without 
changing index, hit the <TAB> key.  
 
Input text 
If this option is selected, the cursor is initially on the input text box when you switch to a search mode: 
 

 
 
 
To move to the Index drop-down without using the mouse, press <SHIFT><TAB>.  
 

Innovative can change the order of the indexes on your system. The order can vary by module. Use the Service 
Commitment on CSDirect to request a change. 
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STATISTICS

The Statistics tab contains the following options for the Statistics mode.  
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PRINT SETTINGS | Login Manager

PRINT SETTINGS

 
 
 
When the Show row and column titles on each page of printouts option is selected, the row and column titles will print on every 
page of printed reports.  
 
If this option is not selected, row and column titles will print only on the first page of printed reports.  
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REPORT SETTINGS | Login Manager

REPORT SETTINGS

 
 
 
Use range notation for orders Range 1 and 2 column titles 
If this option is checked, the name of each range appears in the title of columns that report on a date range.  
 
For example, a particular column title might be "$ in 2002" when this option is selected and "$ in Period 2" when it is not selected: 
 
"Use range notation" selected: 

 
 
 
"Use range notation" not selected: 

 
 
 
Show only the Totals in periodic reports 
If this option is checked, periodic reports display only the composite totals in fields for each range rather than subtotals.  
 
"Show only the Totals" selected: 

 
 
 
"Show only the Totals" not selected: 

 
 
 
Cross Tab horizontal title display 
This option specifies whether the field code (e.g. location code main), field meaning (e.g. Main Library), or both display in cross tab 
reports.  
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Sample cross tab report with codes displayed 

 
 
 
Sample cross tab report with meanings displayed 

 
 
 
Sample cross tab report with both codes and meanings displayed  
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APPLICATION SETTINGS | Login Manager

APPLICATION SETTINGS

 
 
 
Delete the export temp files on application startup 
When exporting query results to a spreadsheet or word processor, Millennium Statistics creates a temporary file in the C:\Temp 
directory on the client PC, which is then opened by the spreadsheet or word processor application. If this box is checked, these 
temporary files are deleted whenever Millennium Statistics is started.  
 

If you choose this option, you must use the spreadsheet or word processing program's Save As option to preserve 
the exported reports. Otherwise, the exported file(s) will be deleted the next time Millennium Statistics is launched 
on the client workstation. 
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EXPORT SETTINGS

 
 
 
These settings specify which application to launch when exporting reports and the format in which the reports are exported. The three 
parameters for both spreadsheet and word processor exporting are: 
 
Name 
Specifies the program name that appears in the Select an export method dialog box.  
 

 
 
 
The defaults are Excel for the spreadsheet and Word for the word processor.  
 
Delimiter 
Specifies the character that separates the data elements in each row in the reports. The default is the ASCII <TAB> character. The 
other options are <COMMA> and <SPACE>.  
 
Extension 
Specifies the filename extension appended to the temporary export file created when reports are exported to the spreadsheet or word 
processor. On some PC operating systems (most notably, Microsoft Windows), applications use the filename extension to associate files 
with the application that opens and edits them. The defaults are XLS for the spreadsheet and RTF for the word processor.  
 
If you have made changes to export settings and later want to restore system defaults, press Default Settings.  
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ACCUMULATION PROCESS LICENSING | Login Manager

ACCUMULATION PROCESS LICENSING

 
 
 
When a report query is run, the Millennium server machine acquires a user license for the process. The user license is released after 
the data has been accumulated. This setting determines if the data accumulation process should occupy an extra license or not. The 
three choices are:  
 
Accumulate in the background 
If this option is chosen, the user can start more than one data accumulation process, or do other work in the application while the 
process is running. This method requires an additional user license, i.e. while the process is running your session uses two user 
licenses. If you start another data accumulation process, a third license will be required, etc. 
Should there be no available license in your Login Group you will get an error message when you start the query:  
 

 
 
 
Always accumulate in the foreground 
If this option is chosen, the user can start only one data accumulation process, and cannot do other work in the application while the 
process is running. This method requires no additional user license. While the query is running a progress report displays:  
 

 
 
 
Ask each time 
If this option is chosen, each time the user starts a data accumulation process, Millennium Statistics asks if the process should run in 
the background (which allows multiple processes). If you answer "Yes", and there is no license available in your Login Group, you will 
get an error message when you start the query. If so, you can start the process again, and choose to run in the foreground (which 
allows one process only) by answering "No" to the question.  
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RECORD TEMPLATES | Login Manager

RECORD TEMPLATES

In the Record Templates tab, you can create, edit, and delete templates. You can also build a login based set of preferred templates 
for each record type.  
 
All templates created in Millennium are stored centrally and accessible to logins as defined in the Record Templates tab.  
 
While the number of templates you can create is unlimited, your Preferred Templates list is limited to a total of 150 preferred templates 
for all record types per login.  
 
The following options are available: 
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PREFERRED/OTHER TEMPLATES | Login Manager

PREFERRED/OTHER TEMPLATES

 
 
 
Follow the steps below for creating or maintaining a list of Preferred Templates: 
 

1.  In the Templates window, choose a record type from the Record Type drop-down menu.
2.  You can view a template by double-clicking the template name in the Preferred Templates or Other Templates list, or by 

selecting the template and then clicking View. The template displays in a record template window. If you are authorized to edit 
templates, the template displays in editable form. If you are not authorized to edit templates, the template displays in read-
only form. 

3.  Add to or remove from your list of Preferred Templates by doing the following: 
 

Add to your list Select the template in the Other Templates list 
and click the left arrow.

Remove from your list Select the template in the Preferred Templates 
list and click the right arrow. 

 
 

4.  To move multiple templates at the same time, select the templates by holding down the Ctrl key and clicking the templates' 
names. Then choose the appropriate arrow button.

 
 
On the Admin » Settings » New Records tab only the templates from your list of Preferred Templates will display for each record 
type. If you set the value to Prompt for template or Always prompt for template Millennium displays your list of Preferred 
Templates from which you can choose a template when you create a new record.  
 

file:///C|/PROJECTS/TUTORIAL%20LoginManager%202008%20-%20UPDATES/print_settings20_1.html (1 of 2) [10/27/2008 11:06:03 AM]



PREFERRED/OTHER TEMPLATES | Login Manager

close window

file:///C|/PROJECTS/TUTORIAL%20LoginManager%202008%20-%20UPDATES/print_settings20_1.html (2 of 2) [10/27/2008 11:06:03 AM]

javascript:window.close()


PREFERRED/OTHER TEMPLATES | Login Manager

PREFERRED/OTHER TEMPLATES

NOTE: To maintain templates, you must be authorized for function 275 (Create templates) and/or 276 (Update templates) and/or 277 
(Delete templates).  
 
The steps for creating templates are similar to those used in creating records in Millennium - you can use many of the same features 
when creating templates as when creating records.  
 
You can create new record templates for all Millennium record types. When you create a template, it is added to the list of Other 
Templates. All users have access to the template.  
 
To create a new record template in Settings, use any of the following methods: 
 

●     Click on the New button in the Templates window. For additional information, refer to the Innovative Guide and Reference, 
Page # 105676: Creating Record Templates

●     Copy an existing template by using the following steps: 

 
 
1. Select a template and click on Edit button, or right click and choose Edit Template: 
 

 
 
 
2. Select Edit|Copy Template  
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For additional information, refer to the Innovative Guide and Reference, Page # 105676:Copying a Template  
 

It is also possible to save an existing record as a template using the record editor. For additional 
information, refer to the Innovative Guide and Reference, Page # 105679: Saving a Record as a 
Template 

 
 
To modify a template, highlight one of the existing entries in the Preferred or Other Templates columns and click on the Edit 
button, or right click and choose Edit Template. For additional information, refer to the Innovative Guide and Reference, Page # 
105676: Editing Record Templates  
 
To remove a template, highlight one of the existing entries in the Preferred or Other Templates columns and click on the Delete 
button, or right click and choose Delete Template. For additional information, refer to the Innovative Guide and Reference, Page # 
105677 Deleting Record Templates  
 
To display a template, highlight one of the existing entries in the Preferred or Other Templates columns and click on the View 
button, or right click and choose View Template.  
 

close window

file:///C|/PROJECTS/TUTORIAL%20LoginManager%202008%20-%20UPDATES/print_settings20_2.html (2 of 2) [10/27/2008 11:06:03 AM]

http://csdirect.iii.com/manual/gmil_settings_template_create.html#gmil_template_create_copy
http://csdirect.iii.com/manual/gmil_settings_template_create.html#gmil_template_create_save_as
http://csdirect.iii.com/manual/gmil_settings_template_create.html#gmil_template_create_save_as
http://csdirect.iii.com/manual/gmil_settings_template_edit.html
http://csdirect.iii.com/manual/gmil_settings_template_delete.html
javascript:window.close()


WEB OPTIONS | Login Manager

WEB OPTIONS

The Web Options tab allows you to determine the WebPAC options files that can be accessed in Web Options mode in Millennium 
Administration.  
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FILE SETTINGS/ADD A FILE | Login Manager

FILE SETTINGS/ADD A FILE

Files listed under File Settings can be accessed in Web Options mode. There are no defaults: 
 

 
 
 
To add a WebPAC Options file to File Settings, complete the following steps:

1.  Select a Filename from the drop-down list under Add a File. The drop-down list is a list of available files in your live and staging 
directories.

2.  Enter a Display Label for the file (e.g. "Staging").
3.  Enter the port(s) for the WebPAC(s) currently using the selected file. By default, the staging file is assigned port 2082 and the 

live file is assigned port 80.
4.  Click Add.
5.  After you save the change by clicking on Save Settings and/or OK, the file(s) will appear in Web Options mode, in Select a 

File list.

To edit display name or port, select an existing file under File Settings: 
 

●     Change the display label as needed.
●     Update the port for the WebPAC using this WebPAC options file, if the port has been changed.
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Changing or setting the port(s) does not change the WebPAC behavior. Changing or setting the port(s) only dictates 
which ports are restarted after you click Restart while the selected WebPAC Options file is open in Web Options 
mode. 

 
 
To remove an existing file from the list of accessible files, click on Remove.  
 
For additional information, refer to the Innovative Guide and Reference, Page # 106807: Updating Web Options  
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WINDOWS | Login Manager

WINDOWS

The Windows tab contains options that specify whether Millennium runs in a single window, or in Multiple Windows mode.  
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WINDOW MODE | Login Manager

WINDOW MODE

 
 
 
Single Window Mode 
If this option is selected, Millennium runs all functions and displays all records in a single window, and each function or record is 
replaced in the window by the next function or record. For example, if you select a record from a browse list, the open record will 
replace the browse list in the window.  
 
Multi Window Mode 
If this option is selected, Millennium opens each new record in a new window. For example, if you select a record from a browse list, 
the record will open in a separate window, leaving the browse list open in a window behind it. A maximum of five windows plus a 
browse window can be open at one time. All open windows can be seen and accessed from the Window menu that will appear on the 
menu bar when this option is checked.  
 

 
 
 
Maximize all windows 
If this check box is selected, windows are maximized when they open (i.e. the newly-opened window fills the computer screen).  
 

A maximum of five windows plus a browse window can be open at one time. When you open a 6th record an error 
message displays: 
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GLOSSARY

Field group tag A one-letter code identifying similar fields for grouping and labelling purposes. All variable-length fields (MARC and non-
MARC) are associated with a field group tag. Multiple MARC tags can share the same field group tag. For example: 
 
a   100   1   Adams, Ansel,|d1902-     (MARC field for author) 
a   110   1   South Africa.|bParliament.     (MARC field for author) 
a   Adams, Ansel     (non-MARC field for author) 
b   30001016825723     (non-MARC field for barcode) 
 
 
Fixed length field Data fields that are of a specified fixed length, e.g. dates, codes, statistical information. The data display in a grid 
in a Millennium record. In most, though not all, cases, valid codes are pre-entered in tables on the system. Refer to the Innovative 
Guide and Reference, Page # 105775: Fixed-length Fields  
 
Item-level Hold A staff member or patron places a hold on an item record (for example, a specific copy of a book or a specific volume 
of a set). An item-level hold is satisfied when that specific item is returned to the library system.  
 
Load table An interface profile - a set of parameters defining which fields will be loaded from a source and how they will be mapped 
when stored within a record. See the Innovative Guide and Reference at Page # 101491: MARC Record Load Table  
 
Title-level Hold A staff member or patron places a hold on the first available copy of a title. A title-level hold may be satisfied when 
any item associated with the specified bibliographic record is returned to the library system.  
 
Variable length field A record field of up to 10,000 characters in length. 
For example: MARC and non-MARC fields in bibliographic, patron, item, checkin, order, course records. Refer to the Innovative Guide 
and Reference, Page # 105783: Variable-Length Fields  
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